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Beleuchtung
Information

HAFELE

Lichtwirkung und Lichttechnik

Lichtkegel

Farbtemperatur

Beleuchtungsstarke

Leuchtmittel im Vergleich

Abstrahlwinkel
|3000 K| 45° Abstand
650 Ix - 250 mm
209 Ix - 500 mm
104 Ix T 750 mm
60 Ix +1000 mm

LED Halogen Leuchtstoff
Farbtemperatur 2700-6500 K 2700-3200 K 2700-6500 K
Leistungsaufnahme 0,5-6 W 5-50 W 7-58 W
Lichtausbeute 80-200 Im/W 12-25 Im/W 60-110 Im/W
Lebensdauer bis 70.000 Std. ca. 2000—4000 Std. ca. 20.000 Std.
Warmeentwicklung ca. 50 °C ca. 90 °C ca. 70 °C
Farbwiedergabeindex (CRI) 80-95 100 50-90
Lichtausbeute im Vergleich
Lichtmenge -
200 Im 400 Im 600 Im 800 Im 1000 Im 1200 Im 1400 Im
LED 2 Watt 5 Watt 10 Watt 15 Watt
@] {C} (@] [e]
Leuchtstoff 8 Watt q 14 Watt > 1
Halogen- 10 Watt 20 Watt 35 Watt 50 Watt
Gliihlampe == == == ==>
. 25 Watt 40 Watt 60 Watt 75 Watt 100 Watt
LI )
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Beleuchtung HAFELE

Information
Lichtfarben und typische Anwendungen
Kerze Gliihlampe direktes Tageslicht
SeE- Sonnenlicht bei Bewodlkung
aufgang

Farbtemperaturin K 1000 2000 3000 4000 5000 6000 7000 8000 9000

Farbtemperatur ‘ Anwendung

2700-4000 K ‘ Wohnraum, Schlafzimmer, Bad
4000-5700 K ‘ Kiiche, Biroraume, Ladenbau
5700-6500 K ‘ Museen, Galerien, Juwelier

Beleuchtungsarten und Leuchtmittel

Beleuchtungsarten LED Halogen Leuchtstoff
Wei Multi-WeiR RGB

Arbeitslicht Jokk ok S kk

Flachiges Licht ok * * ok ook ok

Gerichtetes Licht Jokok Jokok ok *

Dekoratives Licht 2.0.8 ¢ 2.0.8 ¢ Hokok ok *

* = geeignet; %% = gut geeignet; k&% = sehr gut geeignet

Empfehlungen zur Beleuchtung von Innenrdumen

Art des Innenraums Empfohlene Beleuchtungsstarke in Lux
Kuche, Essbereich, Ladenbau 300-500

Schlafzimmer, Wohnzimmer, Badezimmer, Flur, Garderobe 200-300

Lagerraum 100

Orientierungsbeleuchtung 10-50

P. Max. Licht im M&bel, N°3 2023



Beleuchtung HAFELE

Information

Installationsregeln fiir Leuchten in Badern im Wohnbereich

Sollen Leuchten in Raumen mit Badewanne, Dusche und sichtlich des Schutzes vor Feuchtigkeit und Wasser zu
Waschbecken installiert werden, so sind bei der Auswahl der beachten. Die Auswahl und Installation muss eine
Produkte die unten aufgefiihrten Zonen und Schutzarten hin- Gefahrdung durch elektrische Strome ausschlieRen.

600 ——‘

"— 600

Die Abbildung zeigt die Europaische Norm. Fir die Richtigkeit der Angaben wird keine Haftung tbernommen.

Zone 0/Schutzart IPX8: Zone 3/Schutzart IPX0:

Installation von Beleuchtung in der Bade- bzw. Duschwanne.
Hier durfen nur Niedervoltsysteme (max. 12 V Wechselspan-
nung) verwendet werden, die gegen andauerndes Untertau-
chen geschitzt sind.

Uberall auRerhalb von Zone 0, 1 und 2.

IP-Klasse Schutz vor Fremdkorper
Zone 1/Schutzart IPX4: IPX0 kein Schutz vor Tropfwasser

Bereich oberhalb Zone 0 (Badewanne, Duschkabine oder IPX1 Schutz vor fallendem Tropfwasser
Waschbecken) bis zu 2,25 m Hohe. Liegt der Wasser- IPX2 Schutz vor fallendem Tropfwasser bei einer
anschluss, z. B. bei Duschen, dartiber, dann bis zu dieser Gehauseneigung von bis zu 15°

Hohe. Gilt fiir Flachen Uber- und unterhalb von Badewannen
und Duschen. Besteht die Moglichkeit von Strahlwasser,
z. B. durch Wasserdiisen zur Massage, ist Schutzart

IPX3 Schutz vor fallendem Spriihwasser im Winkel
von bis zu 60°

IPX5 erforderlich! IPX4 Schutz vor Spritzwasser

Trafos missen sich aulierhalb von Zone 1 befinden, es sei IPX5 Schutz vor Strahlwasser

denn, die Zuleitung und der Trafo sind fest an die Leuchte

angeschlossen und wasserdicht ausgefiihrt. IPX6 Schutz vor starkem Strahlwasser

IPX7 Schutz vor Schaden nach kurzzeitigem o

oy vvesserlele fbls 2

Schliel3t sich an Zone 1 an. Gilt fir Flachen um Badewanne IPX8 Schutz vor Schaden nach kurzzeitigem ;

oder Dusche mit einer Tiefe von 60 cm bzw. einem Radius Untertauchen auf unbestimmte Zeit 3

von 60 cm bei Handwaschbecken. (max. Tiefe variiert) 8

Besteht die Moglichkeit von Strahlwasser, z. B. durch . =

Wasserdiisen zur Massage, ist Schutzart IPX5 erfor- IPX9 Schutz vor Wasser bei Hochdruck-/Dampf- E

derlich! strahlreiniger E’
-
o



Kele) C
KONFIGURATOR.

Service* MaBgeschneidert-Linearleuchten nach MaB.
Bestellen. Auspacken. Einstecken. Fertig.

Mit dem Héfele Loox-Konfigurator LED-Bander, Aluminiumprofile und Schalter
nach MaB bestellen. In wenigen Schritten zur individuellen Linearleuchte.

Sie haben weniger Arbeitsaufwand, keinen Verschnitt und bekommen Licht

im Mobel fertig zur Montage geliefert.

Der Hafele Loox-Konfigurator steht fir Sie bereit: www.haefele.at/loox-topco

WILLKOMMEN BEIM LOOX-KONFIGURATOR.

01. Profil auswahlen

LED-Linearleuchten nach MagB.

Bereits ab einem Stlck.



Beleuchten - Lineares Licht
LED-Bander, monochrom

Héfele Loox5 LED 3071

LED-Band 24 V, 8 mm, 120 LEDs/m, 4,8 W/m, IP20

e® D

P.MA

MASSMOBEL

> max. visuelle Bandlange bis zu 9,5 m

> dimmbar:
> Einsatzbereich:

ja

Vitrinen,

Regale,

Fachbdden,

Sockel,

hinter Mébeln und Objekten

A

5> > Werkstoff: Kunststoff
= > Farbe: weiB
e > Bandbreite: 8 mm
= > Abschnittlinge: 50 mm
;}// > Kontaktflache Lange: 4 mm
> Anzahl LEDs/m: 120
- i - > Lebensdauer: L80/B10 >30.000 h
im B URD CHC gy B Gfs > Farbwiedergabeindex Ra:  >90
> Farbwiedergabeindex R9:  >50
* *‘pT ‘kc_p i c i c i i > f/lchutzart: IPTS Cebon
4 > Montage: selbstkleben
= _ 4| B g o JH[[re
i M i I Hmvyens } . o .
Maximale Bandlange (visuell) beschreibt einen Bandabschnitt,
% ’ ‘ % o E [ I !nnerhalb dessen der Li__chtstr.omabfall visuelllnic.ht wahrnehmbar
(@) =, ist und max. 30 % betragt. Bitte beachten: ein direkt folgender
My " |u Bandabschnitt mit Neueinspeisung ist wahrnehmbar heller.
v = I V Maximale Ieistungs§bhéngig? Bandlange am Netzteil sieche
T———— o o o o oo Technische Daten fur LED-Béander.
52T 55| |~16] i

» X LED-Band ablangen
(eine Kontaktseite verbleibt am Reststiick;
weiterverwendbar)

PIX XK LED-Bander verbinden
(zwei Kontaktseiten erforderlich)

C = Abschnittldnge
P = Lénge Kontaktflache

|2700 K| 3000 K|4000 K|5000 K| 120°

1140 Ix 1190 Ix 1250 Ix 1250 Ix :j:o:: 250 mm
4701x 4901x 5101x 510 Ix ok 500 mm
2501x 265Ix 280Ix 280 Ix 20- 750 mm

1551x 160Ix 1701x 170 Ix -0- 1000 mm

Beleuchtungstarke in Ix bezogen auf 1 m Bandlange

Farbtem- Lichtfarbe ‘ Leistung/m ‘ Lichtstrom/m ‘ Lichtausbeute ‘ max. Bandlédnge ‘ Energie- ‘ Artikel-Nr.
peratur K ‘ w ‘ Im ‘ Im/W ‘ (visuell) m ‘ effizienzklasse ‘ 25m ‘ 5m
3000 ‘ warmweif ‘ 4,8 ‘ 460 ‘ 96 ‘ 9,5 0 F ‘ 833.86.150 ‘ 833.86.151
4000 ‘ kaltweiB ‘ 48 ‘ 480 ‘ 100 ‘ 9,5 i F ‘ 833.86.152 ‘ 833.86.153

Bestellhinweis:
Schalter separat bestellen (ab Seite 33)

passend zum Set sind im Lieferumfang enthalten:
> LED-Band 3071

> Zuleitungen

> ECO-Netzteil mit Schaltfunktion

> 2 m Einspeisleitung

> Clipverbinder

> Verbindungsleitungen

ﬁ IP20 @ °@“s

Abpackung: 1 Stlick

P. Max. Licht im Mébel, N°3 2023
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Beleuchten - Lineares Licht
LED-Bander, monochrom P. MSABEL

Héfele Loox5 LED 3074

LED-Band 24 V, 8 mm, 120 LEDs/m, 9,6 W/m, IP20

e® D

> Bandlénge visuell bis zu 6,5 m A

> dimmbar: ja
> Einsatzbereich: Vitrinen,
Regale,
Fachboden,
Sockel,
hinter Mébeln und Objekten
> Werkstoff: Kunststoff
> Farbe: weiB
> Bandbreite: 8 mm
> Abschnittlange: 50 mm
> Kontaktflache Lange: 4 mm
> Anzahl LEDs/m: 120
P e = il > Lebensdauer: L80/B10 >30.000 h
o IixE miD il @ Wys > Farbwiedergabeindex Ra:  >90
> Farbwiedergabeindex R9:  >50
* *‘pT ‘kc_p i c i c i i > f/lchutzart: IPT: Cebon
4 > Montage: selbstkleben
= _ 4| B 2 o H[[Te
i M i I Hinvyeis i . o .
Maximale Bandlange (visuell) beschreibt einen Bandabschnitt,
% ’ ‘ % o E [ I !nnerhalb dessen der Li_.chtstr.omabfall visuelllnic.ht wahrnehmbar
O o ist und max. 30 % betragt. Bitte beachten: ein direkt folgender
My " |u Bandabschnitt mit Neueinspeisung ist wahrnehmbar heller.
v =r V Maximale Ieistungs§bhéngig? Bandlange am Netzteil sieche
B Al [ Technische Daten fiir LED-Bénder.
"’T 55 |16~ ;

Bestellhinweis:

M X LED-Band ablangen Schalter separat bestellen (ab Seite 33)

(eine Kontaktseite verbleibt am Reststiick;

weiterverwendbar]
) passend zum Set sind im Lieferumfang enthalten:

PIX XK LED-Bénder verbinden > LED-Band 3074
(zwei Kontaktseiten erforderlich) > Zuleitungen
C = Abschnittlange > ECO-Netzteil mit Schaltfunktion
P = Lénge Kontaktflache > 2 m Einspeisleitung
> Clipverbinder
|2700 K| 3000 K|4000 K|5000 K 120° > Verbindungsleitungen
1140 Ix 1190 Ix 1250 Ix 1250 Ix :::o:: 250 mm
4701x 4901x 5101x 510 Ix :::o:: 500 mm
2501x 265Ix 2801Ix 280 Ix -jq:J:- 750 mm
1551x 160 Ix 1701x 170 Ix J0- 1000 mm

Beleuchtungstarke in Ix bezogen auf 1 m Bandlange

ﬁ IP20 @ °@“s

Farbtemperatur ‘ Lichtfarbe ‘ Leistung/m ‘ Lichtstrom/m ‘ Lichtausbeute ‘ max. Bandlédnge ‘ Energie- ‘ Artikel-Nr.
K ‘ w ‘ Im ‘ Im/W ‘ (visuell) m ‘ effizienzklasse ‘ 25m

3000 ‘ warmweif ‘ 9,6 ‘ 905 ‘ 94 ‘ 6,5 HF ‘ 833.86.154
4000 ‘ kaltweiB ‘ 9,6 ‘ 960 ‘ 100 ‘ 6,5 0 F ‘ 833.86.155

Abpackung: 1 Stuck

|



Beleuchten - Lineares Licht p. M Ax
Glaskantenprofile MASSMOBEL

Glaskantenprofil, Profil 5101 (ohne LED-Band)

> Ausflihrung: Lichtaustritt nach unten
> Werkstoff: Aluminium
Montagehinweis

Glasboden muss separat befestigt werden, keine tragende

Funktion
Hinweis
- 16.5 |= gf Fir LED-Bénder bis 10 mm Breite.
T4 ‘ — MaB in Ki i Nur fir LED-Bénder mit max. 10 W/m
i ) v a '”t (‘;‘Imrg?'; ()8 ur Vor dem Kleben der LED-Streifen die zu beklebende Fliche
b 60° r ariante lasaicke 6 mm der Aluprofile unbedingt reinigen. Sie sollte absolut schmutz-,
& / fett- und staubfrei sein!
) Bestellhinweis Fiir homogenes Licht ohne Punkte bitte COB-Band LED 3069
<20 Streuscheibe bitte separat bestellen. (Seite 2.32) verwenden.
Lange fiir Glasdicke Farbe/Oberflache Artikel-Nr.
mm mm
2500 6 ' Profil: schwarz, eloxiert 1 833.02.694
‘ 6 ‘ Profil: silberfarben, eloxiert ‘ 833.02.693
8 ' Profil: schwarz, eloxiert 1833.02.696
8 ' Profil: silberfarben, eloxiert 1 833.02.695

Streuscheibe: milchig
Abpackung: 1 Stiick

. > Werkstoff: Kunststoff
> Verwendbar fir: Unterbauprofil
> Montage: zum Einpressen
Farbe/Oberflache Lichtdurchlassigkeit 2000 mm 2500 mm 6000 mm
schwarz 25 % - 833.01.852 | 833.01.858
satiniert 54 % 1833.01.762 | 833.01.786  833.01.791
transparent 190 % 1833.01.763 | 833.01.787  833.01.793
Abpackung: 1 Stlick
Glaskantenprofil Hafele Loox, Profil 5108 (ohne LED-Band)
|——— 22 —
o ~9~ > Einsatzbereich:  zur Anfertigung einer Glaskantenbeleuchtung
N + > Werkstoff: Profil: Kunststoff,
\\ Streuscheibe: Kunststoff
> fur Glasdicke: 4-8 mm
> Innenbreite: 15 mm
S > Montage: zum Aufstecken
Hinweis
Fir LED-Bander bis 10 mm Breite. Nur fir LED-Bénder mit max.
> Zur Anfertigung einer individuellen Glaskanten- 9,6 W/m geeignet. MaBe des Clipverbinders beachten.
Beleuchtung. Keine tragende Funktion.
> Wirkung der Glaskante auf das Licht: Vor dem Kleben der LED-Streifen die zu beklebende
Glaskante satiniert = gleichmaBige Lichtlinie ] Flache unbedingt reinigen. Sie sollte absolut schmutz-, -
Glaskante klar = Punktlicht Jeii el sl el , o S
Um eine bessere Lichtverteilung zu erzielen, empfiehlt sich, «
die Glaskante hinten zu mattieren. E'Z)
Lieferumfang kol
1 Glaskantenprofil 8
=
Lidnge mm Farbe/Oberflache Artikel-Nr. =
2000 Profil: silberfarben, 833.74.733 £
8
%
©
=
o

@ passendes LED-Band 3071, 3074 » Seite 6-7




Beleuchten - Lineares Licht
Unterbauprofile

P.MA

MASSMOBEL

Unterbauprofil, Hafele Loox, Profil 2190 (ohne LED-Band)

> Werkstoff: Profil: Aluminium,

Streuscheibe: Kunststoff
> Innenbreite: 16 mm
> Streuscheibe Breite: 18 mm

> Montage: zum Schrauben mit Montageklammer
bzw. zum Kleben mit Klebeband
833.89.266
i Hinweis

; "o - Fir LED-Béander bis 10 mm Breite.
=16 < Dauerbetrieb (=8 Stunden/Tag) nur mit LED-Bandern bis 9,6 W/m.
LF a‘ﬁj Maximaler Abstand der Montageklammern betragt 500 mm.
18 Vor dem Kleben der LED-Streifen die zu beklebende Flache
unbedingt reinigen. Sie sollte absolut schmutz-, fett- und staub-
frei sein!

9.5

Streuscheiben

Bei Verwendung dieses Profils sind die LED-Punkte immer sicht-
bar.

Fir homogenes Licht ohne Punkte bitte COB-Band verwenden.

Lieferumfang

1 Profil

1 Streuscheibe

Farbe/Oberflache Liange Artikel-Nr.
mm

Profil: silberfarben, eloxiert, 2500 833.72.981

Streuscheibe: opal
Abpackung: 1 Stiick

Bestellhinweis
Montageklammern (optional) bitte separat bestellen

— Montageklammer fiir Unterbauprofil Hafele Loox, Profil 2190, 2191

N rﬁ\ > Werkstoff: Edelstahl
f . > Lange: 22 mm
)
?"-\‘ { > Montage: zum Schrauben
) Hinweis

Montageklammer 40°

Montageklammer 90°

Maximaler Abstand der Montageklammern 500 mm

Lieferumfang

1 Paar Montageklammern inkl. Befestigungsmaterial

Farbe/Oberflache Winkel ° Artikel-Nr.
silberfarben 40 833.74.833
silberfarben 90 833.74.832

Abpackung: 1, 10 oder 100 Paar

— Endkappe, fiir Unterbauprofil Hafele Loox, Profil 2190

> Werkstoff:
> Ausstattung:

Kunststoff
mit Kabeldurchlass

i Lieferumfang

I 1 Paar Endkappen

[ap]

> Farbe/Oberflache Abpackung Artikel-Nr.
5 Paar

Re silberfarben 1, 10 oder 100 833.72.852
=

S

=

Q

.|

gé O Aluminiumprofil-Schalter Hafele Loox5 » Seite 40

=

o



Beleuchten - Lineares Licht

Glaskantenprofile

P.MAX

MASSMOBEL

Unterbauprofil, Hafele Loox, Profil 2191 (ohne LED-Band)

> Werkstoff:
> Innenbreite:

> Streuscheibe Breite:
> Montage:

Hinweis

Profil: Aluminium,
Streuscheibe: Kunststoff

16 mm
18 mm

zum Schrauben mit Montageklammer
bzw. zum Kleben mit Klebeband
833.89.266

Fir LED-Bander bis 10 mm Breite.
Maximaler Abstand der Montageklammern betragt 500 mm.

Lieferumfang
1 Aluminiumprofil
1 Streuscheibe

Farbe/Oberflache

Profil: silberfarben, eloxiert, | 2500

Streuscheibe: opal

Lange Artikel-Nr.
mm
833.72.982

Abpackung: 1 Stuck

Bestellhinweis

Montageklammern (optional) bitte separat bestellen

— Montageklammer fiir Unterbauprofil Hafele Loox, Profil 2190, 2191

-c_'&_"

b\\' %

Montageklammer 40°

Montageklammer 90°

> Werkstoff:
> Lange:
> Montage:

Hinweis

Edelstahl
22 mm
zum Schrauben

Maximaler Abstand der Montageklammern 500 mm

Lieferumfang

1 Paar Montageklammern inkl. Befestigungsmaterial

Farbe/Oberflache
silberfarben
silberfarben

Winkel ° Artikel-Nr.
40 833.74.833
90 833.74.832

Abpackung: 1, 10 oder 100 Paar

— Endkappe, fiir Unterbauprofil Hafele Loox, Profil 2190

iy
(=}

> Werkstoff:
> Ausstattung:

Lieferumfang
1 Paar Endkappen

Kunststoff
mit Kabeldurchlass

Farbe/Oberflache Abpackung Artikel-Nr.
Paar
silberfarben 1, 10 oder 100 833.72.852
O Aluminiumprofil-Schalter Hafele Loox5 » Seite 40

P. Max. Licht im Mébel, N°3 2023
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Beleuchten - Lineares Licht p. M A
Unterbauprofile MASSMOBEL

Unterbauprofil, Hafele Loox5, Profil 2101 (ohne LED-Band)

> Werkstoff: Aluminium,
Streuscheibe: Kunststoff
> Innenbreite: 11 mm

> Streuscheibe Breite: 13 mm

Hinweis

Fir LED-Bander bis 8 mm Breite.

Vor dem Kleben der LED-Streifen die zu beklebende Flache
der Aluprofile unbedingt reinigen. Sie sollte absolut schmutz-,
fett- und staubfrei sein!

Streuscheiben

Durch die opale Streuscheibe entsteht ein gleichmaBiges Licht
ohne Punkte ab 120 LEDs/m. Punkte sind sichtbar bei schwar-
zer Version. Alternative Streuscheiben in schwarz bei Bedarf
bitte separat bestellen.

~

~—11-=]

Montagehinweis:
Zur Befestigung bitte Klebeband 833.89.266 verwenden.

Lieferumfang

1 Aluminiumprofil

L4 . aufgesetzte 1 Streuscheibe opal
|<—13—~ «,T Streuscheibe

10.7 =

Farbe/Oberfliche ‘ Licht- ‘ 2500 mm ‘ 3000 mm
durchléassigkeit

Profil: schwarz, eloxiert, Streuscheibe: opal 1 70-80 % 1833.94.111 | 833.95.733

Profil: edelstahlfarben, eloxiert, gebirstet, ‘ 70-80 % ‘ 833.94.112 ‘ 833.95.762

Streuscheibe: opal

Profil: silberfarben, eloxiert, Streuscheibe: opal | 70-80 % 1833.94.110 | 833.95.732

Abpackung: 1 Stiick

— Endkappe fiir Unterbauprofil Hifele Loox5, Profil 2101

o = F > Werkstoff: Kunststoff
o o~ > Ausfuhrung: mit Bohrmarkierung fur Kabeldurchlass
25| 4] > Verwendbar fiir: Unterbauprofil Hafele Loox5, Profil 2101
Farbe/Oberflache Artikel-Nr.
schwarz ‘ 833.95.775
edelstahlfarben, geburstet ‘ 833.95.776
silberfarben 833.95.774

Abpackung: 10 Stlick / 50 Stick

Streuscheibe, Hafele Loox fiir Unterbauprofil 2101

.y i R > Werkstoff: Kunststoff
. 1z} Hinweis
. Durch die opale Streuscheibe entsteht ein gleichmaBiges Licht
ohne Punkte ab 120 LEDs/m. Punkte sind sichtbar bei schwar-

zer und transparenter Version.

Lieferumfang
1 Streuscheibe

Breite Farbe/Oberfliche Lichtdurchléssigkeit ‘ 2500 mm ‘ 3000 mm
mm

13 “opal 1 70-80 % 1833.95.806 | 833.95.756
13 'schwarz ~20 % 1833.95.810 | 833.95.760

Abpackung: 1 Stlick



Beleuchten - Lineares Licht p M Ax
Eckprofile ® MASSMOBEL

Eckprofil Hafele Loox, Profil 2195 (ohne LED-Band)

> Werkstoff: Profil: Aluminium,
Streuscheibe: Kunststoff
> Innenbreite: 14 mm
> Montage: zum Kleben mit Klebeband 833.89.266
Hinweis

Fur LED-Bé&nder bis 10 mm Breite.

Vor dem Kleben der LED-Streifen die zu beklebende Flache
unbedingt reinigen. Sie sollte absolut schmutz-, fett- und
staubfrei sein!

Lieferumfang
1 Aluminiumprofil
1 Streuscheibe

Profil: silberfarben, eloxiert, 833.72.987
Streuscheibe: opal

Abpackung: 1 Stuck

— Endkappe, fiir Eckprofil Hafele Loox, Profil 2195

> Werkstoff: Kunststoff
> Ausstattung: mit Kabeldurchlass

Lieferumfang
1 Paar Endkappen

silberfarben 833.74.822
Abpackung: 1, 10 oder 100 Paar

— Seitentrager fiir Eckprofil Hafele Loox, Profil 2195

> Werkstoff: Kunststoff
> Montage: zum Schrauben

Lieferumfang
1 Paar Seitentrager

silberfarben 833.74.825
Abpackung: 1 oder 10 Paar

— Montageklammer fiir Eckprofil Hafele Loox, Profil 2195

> Werkstoff: Edelstahl
> Montage: zum Schrauben

Lieferumfang
1 Paar Montageklammern

silberfarben 833.74.826
Abpackung: 1 oder 10 Paar

P. Max. Licht im Mdbel, N°3 2023



LOOXS5 ECO
SCHALTEN & VERTEILE

' Versorgen

Netzteil Loox5 Eco
> mit Schaltfunktion

> extra flach 16 mm

> 24-V-Netzteile mit Stecksystem der Generation Loox5

> Einsatzbereich fir LED-Leuchten (nicht fir andere Verbraucher)
> Hinweis: flr Dauerbetrieb bitte Loox5-Netzteil mit 50.000 h Lebensdauer verwenden.




Beleuchten — Punktlicht
Ein-/Unterbauleuchten, modular, monochrom

Héfele Loox5 LED 3092

Leuchtenmodul 24 V, 3,4 W, Bohrlochdurchmesser: 58 mm, IP44

Cfic X2

P.MA

MASSMOBEL

modulares System: freie Gestaltungsmdglichkeiten mit
wechselbaren Gehdusen und Zuleitungen

Leuchte mit integrierter Kabelbuchse fiir schnelles
Umristen

ausgestattet mit hochwertigen Samsung-LEDs

dimmbar: ja

Einsatzbereich: Arbeitsplatzbeleuchtung,
Kutchen- und Wohnmobel,
Theken

Gehause Werkstoff: Aluminium

Anzahl| LEDs: 6

Lebensdauer: 50000 h

Farbwiedergabeindex Ra:  >90

Farbwiedergabeindex R9:  >55

gewichteter Energie- 3,74 kWh/1000 h

verbrauch:

Energieeffizienzklasse: G

Montage: zum Einbohren und Klemmen
oder zum Schrauben

Bohrlochdurchmesser: 58 mm

Hinweis

Die Schutzart IP44 verringert sich bei Verwendung eines
Unterbaugehauses auf IP20.

Bestellhinweis:
Schalter separat bestellen (ab Seite 32)

Immer erforderlich: %
@ Leuchtenmodul, @ Gehause, ® Zuleitung %

|2700 K| 3000 K|4000 K |5000 K| 80°

passend zum Set sind im Lieferumfang enthalten:
> LED 3092 mit Einbau- oder Unterbaugehause
> Zuleitungen

1870 Ix 1990 Ix 2025 Ix 2135 Ix =0: 250 mm o .
! > ECO-Netzteil mit Schaltfunktion
5001x 5401x 540 Ix 580 Ix B 500 mm > 2 m Einspeisleitung
2101x 2301x 235Ix 240 Ix -j::- 750 mm
1201x 1251x 1301x 135 Ix p % 1000 mm

¥ 1P20
S Lo T ag @ “@“s

© Schalter und Sensoren Loox » Seite 32
@ Steuerungskomponenten Connect Mesh » Seite 45
O Installationsregeln in Badezimmern » Seite 4

im Wohnbereich

-
H
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Beleuchten — Punktlicht
Ein-/Unterbauleuchten, modular, monochrom

Héfele Loox5 LED 3092

P.MA

MASSMOBEL

Farbe Earbtemperatur Set Artikel-Nr. Farbe Earbtemperatur Set Artikel-Nr.
Héfele Loox5 LED 3092 - Einbauleuchte Héfele Loox5 LED 3092 - Unterbauleuchte
celstatfarben . 2er 833.86.160 edelstahifarben . 2er 833.86.162
warmweif3 3000 K 3er 833.86.164 warmweif3 3000 K 3er 833.86.166
% 4er 833.86.168 4er 833.86.170
t ) 2er 833.86.161 2er 833.86.163
-~ kaltwei3 4000 K 3er 833.86.165 kaltweif3 4000 K 3er 833.86.167
der 833.86.169 der 833.86.171
<chwars . 2er 833.86.172 schwarz . 2er 833.86.174
warmweif3 3000 K 3er 833.86.176 warmweif3 3000 K 3er 833.86.178
der 833.86.180 der 833.86.182
6 2er 833.86.173 2er 833.86.175
kaltwei3 4000 K 3er 833.86.177 kaltwei3 4000 K 3er 833.86.179
der 833.86.181 der 833.86.183
2er 833.86.184 2er 833.86.186
edelstahifarben warmweiB 3000 K 3er | 833.86.188 CoCoanarben warmweiB 3000 K 3er | 833.86.190
:ﬂﬁ der 833.86.192 der 833.86.194
- 2er 833.86.185 2er 833.86.187
o kaltwei3 4000 K 3er 833.86.189 kaltwei3 4000 K 3er 833.86.191
4er 833.86.193 4er 833.86.195
2er 833.86.196 2er 833.86.198
schwarz . schwarz .
warmweif3 3000 K 3er 833.86.200 warmweif3 3000 K 3er 833.86.202
4er 833.86.204 4er 833.86.206
ﬂ 2er 833.86.197 2er 833.86.199
kaltwei3 4000 K 3er 833.86.201 kaltweif3 4000 K 3er 833.86.203
der 833.86.205 der 833.86.207
e [l il Sl Sl
T S ax T T
§l—om— ' e : - e
065 65 065 65

Einbaumontage rund

Einbaumontage eckig

* ist gultig fir Multi-WeiB-Stecker am Multi-WeiB-Leuchtenmodul

Unterbaumontage rund

Unterbaumontage eckig

* ist guiltig fir Multi-WeiB-Stecker am Multi-WeiB-Leuchtenmodul



Beleuchten — Punktlicht
Ein-/Unterbauleuchten, monochrom

Héfele Loox5 LED 3090

Leuchtenmodul 24 V, 1,2 W, Bohrlochdurchmesser: 26 mm, IP44

P.MA

MASSMOBEL

DO

> ausgestattet mit hochwertigen Samsung-LEDs

> schmaler Abstrahlwinkel fiir Inszenierung von Objekten =

passend fur Mini-Topfscharnier-Bohrung 26 mm

dimmbar:
Einsatzbereich:

Gehause Werkstoff:
Anzahl LEDs:
Lebensdauer:

ja

Kichen- und Wohnmdbel,
Vitrinen

Aluminium

1

50000 h

>90

Farbwiedergabeindex R9:  >60

>

>

>

> Farbwiedergabeindex Ra:
>

> Energieeffizienzklasse: G
>

Montage: zum Einbohren und Klemmen
oder zum Schrauben
> Bohrlochdurchmesser: 26 mm
Hinweis

Die Schutzart IP44 verringert sich bei Verwendung eines
Unterbaugehaduses auf IP20.

Bestellhinweis:
Schalter separat bestellen (ab Seite 32)

passend zum Set sind im Lieferumfang enthalten:
> LED 3090 mit Einbau- oder Unterbaugehduse
> Zuleitungen

2700 K[3000 K 4000 K|5000 K 55° > ECO-Netzteil mit Schaltfunktion
825Ix 870Ix 935Ix 940 Ix X% 250 mm > 2 m Einspeisleitung

2001x 2251x 235Ix 245 Ix 20- 500 mm

951x  95I1x 100Ix 105 Ix b % 750 mm

501x 551x 55Ix 60 Ix ) X 1000 mm

¥ 1P20
ﬁ O TS Pas @ “@“s

© Schalter und Sensoren Loox » Seite 32
@ Steuerungskomponenten Connect Mesh » Seite 45
O Installationsregeln in Badezimmern » Seite 4

im Wohnbereich

iy
(<2}
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Beleuchten — Punktlicht
Ein-/Unterbauleuchten, monochrom p’ Msﬁssa

Héfele Loox5 LED 3090

Farbe Earbtemperatur Set Artikel-Nr. Farbe Earbtemperatur Set Artikel-Nr.
Hafele Loox5 LED 3090 - Einbauleuchte Héafele Loox5 LED 3090 - Unterbauleuchte
2er 833.86.208  edelstahifarben 2er 833.86.378
edelstahlfarben warmweiB 3000 K 3er | 833.86.219 warmweiB 3000 K | 3er | 833.86.380
y pﬂum der 833.86.211 \ der 833.86.382
( By 2er 833.86.209 2er 833.86.379
: kaltweiB 4000 K 3er 833.86.210 1 /' kaltweiB 4000 K 3er 833.86.381
der 833.86.221 der 833.86.383
schwarz 2er 833.86.213  schwarz 2er 833.86.384
warmwei3 3000 K 3er 833.26.215 warmweif3 3000 K 3er 833.86.386
der 833.86.217 der 833.86.388
er 833.86.214 2er 833.86.385
kaltweiB 4000 K 3er 833.86.216 kaltweiB 4000 K 3er 833.86.387
der 833.86.218 der 833.86.389
2er 833.86.225 edelstahlfarben 2er 833.86.390
edelstahlfarben warmweiB 3000 K | 3er | 833.86.221 warmweiB 3000 K 3er | 833.86.392
4 rﬂma der 833.86.223 der 833.86.394
L’ i 2er 833.86.220 ‘ 2er 833.86.391
\; : / kaltweiB 4000 K 3er 833.86.222 \1. ( > / kaltweiB 4000 K 3er 833.86.393
der 833.86.224 der 833.86.395
2er 833.86.226  schwarz 2er 833.86.396
schwarz warmweiB 3000 K 3er  833.86.228 warmweiB 3000 K 3er | 833.86.308
der 833.86.230 der 833.86.400
2er 833.86.227 2er 833.86.397
kaltweiB 4000 K 3er 833.86.229 kaltweiB 4000 K 3er 833.86.399
der 833.86.231 der 833.86.401
2 I 28 |1

il il
I

T 1 HE 1 HE 1
3 Lj AL L = = =
Temd ' dlmd ] E
5—

~—32.5— |- @325~ |~—82.5—

~14=]

Einbaumontage rund Einbaumontage eckig Unterbaumontage rund Unterbaumontage quadratisch

-t
~J



Beleuchten — Punktlicht
Ein-/Unterbauleuchten, monochrom p' Msﬁmxﬂ

Hafele Loox LED 3038

Einbauleuchte, 24 V, 3 W, Bohrlochdurchmesser: 55 mm

Bl ¢

> hochwertiges Metallgehduse A

> homogene Ausleuchtung

> dimmbar: ja

> Einsatzbereich: fur Vitrinen, Regale und
Fachbdden

> Gehause Werkstoff: Stahl

> Anzahl LEDs: 24

> Lebensdauer: 30000 h

> Energieeffizienzklasse: G

> Montage: zum Einbohren und Klemmen

> Bohrlochdurchmesser: 55 mm

Bestellhinweis:
Schalter separat bestellen (ab Seite 32)

passend zum Set sind im Lieferumfang enthalten:
— > LED 3038

@65 > Zuleitungen

Einbaumontage > ECO-Netzteil mit Schaltfunktion

> 2 m Einspeisleitung

|3000 K|4000 K 5000 K| 120°

5801x 5901x 7101 o 250 mm
220 Ix 220 1Ix 265 Ix -jc:aj- 500 mm
1151x  1151x 140 Ix N 750 mm
75Ix  75Ix 100 Ix :é: 1000 mm
% 25 1poo © @
Gehausefarbe Farbtemperatur Lichtfarbe Lichtstrom Leistung | Lichtausbeute Farbwieder- Artikel-Nr.
gabeindex
K Im w Im/W Ra
edelstahlfarben 3000 warmweil 215 3 72 90 2er 833.86.232

3er 833.86.234
4er 833.86.236
4000 kaltweiB 225 3 75 90 2er 833.86.233
3er 833.86.235
der 833.86.237
silberfarben 3000 warmweiB 215 3 72 90 2er 833.86.238
3er 833.86.240
4er 833.86.242
4000 kaltweiB 225 3 75 90 2er 833.86.239
3er 833.86.241
der 833.86.243
verchromt, 3000 warmweil3 215 3 72 90 2er 833.86.244
poliert 3er  833.86.246

4er 833.86.248

m 4000 kaltweiB 225 3 75 90 2er 833.86.245
— 3er 833.86.247
der 833.86.249

-
o]

P. Max. Licht im Mébel, N°3 2023
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Beleuchten — Punktlicht p. M A
Unterbauleuchten, monochrom MASSMOBEL

Héfele Loox5 LED 3036

Unterbauleuchte 24 V, 2,5 W, IP20

Bl oM

minimale Bauhéhe 6 mm

homogene Ausleuchtung

durch integrierten IC auch fur kurzzeitge u
Spannungspitzen bis 26,4 V geeignet A

dimmbar: ja

Einsatzbereich: Schrénke, Regale, Vitrinen, Fach-
boéden

Gehause Werkstoff: Kunststoff

Gehause silberfarben

Farbe/Oberflache:

Streuscheibe Werkstoff: Kunststoff

Streuscheibe weiB, opal

Farbe/Oberflache:

MaBe (L x B x H): 65 x 65 x 6 mm

Anzahl LEDs: 7

Lebensdauer: L80/B10 30.000 h

Farbwiedergabeindex Ra: =90
Farbwiedergabeindex R9:  >50
Energieeffizienzklasse: G

Schutzart: IP20

Montage: zum Kleben
oder zum Schrauben

© Bestellhinweis:
QL Schalter separat bestellen (ab Seite 32)
I

passend zum Set sind im Lieferumfang enthalten:
‘ > LED 3036

|
- g > Zuleitungen
65 > ECO-Netzteil mit Schaltfunktion

> 2 m Einspeisleitung

|
e E— I:

|2700 K|3000 K|4000 K|5000 K| 105°
7951x 825Ix 880 Ix 880 Ix B 250 mm
2161x 225Ix 240 1Ix 240 Ix -j::- 500 mm
951x 1001x 105Ix 105 Ix ::: 750 mm
551x  55Ix 60Ix 60 Ix b 1000 mm
o 0y
CA S\ @ P20
Gehdausefarbe Farbtemperatur  Lichtfarbe Lichtstrom Leistung Lichtausbeute Artikel-Nr.
K Im w Im/W
silberfarben 2700 warmweiB 140 2,5 56 2er 833.86.250

3er 833.86.253
4er 833.86.256
3000 warmweil 145 2,5 58 2er 833.86.251
3er 833.86.254
4er 833.86.257
4000 kaltweiB 155 2,5 62 2er 833.86.252
3er 833.86.255
4er 833.86.258




Beleuchten — Punktlicht
Unterbauleuchten, monochrom

Unterbauleuchte 24 V, 4,8 W

® D

P.MAX

MASSMOBEL

Hafele Loox LED 3023

> homogene, flichige Ausleuchtung
> extrem flache Bauform
> ideal zum Nachristen

> dimmbar: ja

> Einsatzbereich: fir gleichmaBige Ausleuchtung
von Schréanken und Kiichen

> Gehause Werkstoff: Kunststoff

> Gehause silberfarben
Farbe/Oberflache:

> Streuscheibe Werkstoff: Kunststoff

> Streuscheibe weif, opal
Farbe/Oberflache:

> MaBe (J x H): 180 x 6,2 mm

> Anzahl LEDs: 77

> Lebensdauer: 30000 h

> Farbwiedergabeindex Ra: 82

> Energieeffizienzklasse: G

> Montage: zum Schrauben

> Montagehinweis: Ideal zum Nachrusten

Bestellhinweis:
Schalter separat bestellen (ab Seite 32)

28 =
g LTI T I IT Il
[ " passend zum Set sind im Lieferumfang enthalten:
of | 2180 | > LED 3023
> 2 m Zuleitungen
> ECO-Netzteil mit Schaltfunktion
3000 K|4000 K 110° > 2 m Einspeisleitung
S > inklusive Befestigungsmaterial
1874 Ix 2273 Ix :,I\: 250 mm
4681x 568 Ix 30 500 mm
! + %%"‘
2081x 252 Ix -0: 750 mm <
171x 142 Ix b ¢ 1000 mm
7\
=
=7 =@"s D 1p2g ﬁ %ol
Gehausefarbe Farbtemperatur Lichtfarbe Lichtstrom Leistung Lichtausbeute Artikel-Nr.
K Im w Im/W
silberfarben ‘4000 ‘kaltweiB ‘408 ‘4,8 ‘85 ‘1er ‘833.86.259
\ \ \ \ \ ‘2er ‘833.86.260
‘ ‘ ‘ ‘ ‘ ‘Ser ‘833.86.261
@ Schalter und Sensoren Loox » Seite 32
@ Steuerungskomponenten Connect Mesh » Seite 45

P. Max. Licht im Mébel, N°3 2023



Beleuchten — Punktlicht
Unterbauleuchten, monochrom

P.MA

MASSMOBEL

Hafele Loox LED 3025

Unterbauleuchte, 24 V, 5,8 W

El ¢

o > homogene, flichige Ausleuchtung

> sehr flache Bauform
._.‘* > ideal zum Nachrusten

Montagehinweis:

- —
> dimmbar: ja
> Einsatzbereich: fur gleichmaBige Ausleuchtung
von Schranken, Kiichen und
Arbeitsflachen
> Gehause Werkstoff: Kunststoff
Gehause silberfarben
Farbe/Oberflache:
Streuscheibe Werkstoff: Kunststoff
> Streuscheibe weiB, opal
Farbe/Oberflache:
> MaBe (L x B x H): 205 x 205 x 6,2 mm
> Anzahl LEDs: 70
> Lebensdauer: 30000 h
> Energieeffizienzklasse: F
> Montage: zum Schrauben,

zum Aufsetzen
Ideal zum Nachristen

P. Max. Licht im M&bel, N°3 2023

%‘ - > Kabellange: 2000 mm
AT T T TT I JT Bestellhinweis:
L ! Schalter separat bestellen (ab Seite 32)
gT | 1205 |

passend zum Set sind im Lieferumfang enthalten:
> LED 3025
> 2 m Zuleitungen

3000 K|4000 K 110°

2153 Ix 2581 Ix =02 250 mm o )
! > ECO-Netzteil mit Schaltfunktion
538 Ix 645 Ix 0% 500 mm > 2 m Einspeisleitung
e > inklusive Befestigungsmaterial
239 Ix 286 Ix -0: 750 mm
1341x 161 Ix ' 1000 mm

s
E
+
=+

~
.:
S7 @ @ pog ﬁ il

Gehausefarbe Farbtemperatur Lichtfarbe Lichtstrom Leistung Lichtausbeute Artikel-Nr.
K Im W Im/W

silberfarben ‘ 4000 ‘ kaltweiB ‘ 530 ‘ 5,8 ‘ 91 ‘ 1er ‘ 833.86.262

\ \ \ \ \ er \ 833.86.263

‘ 3er ‘ 833.86.264

» Seite 32
» Seite 45

@ Schalter und Sensoren Loox

@ Steuerungskomponenten Connect Mesh




Beleuchten — Punktlicht
Anbauleuchte, flexibel, monochrom

Anbauleuchte, flexibel, 24V, 1,5 W

A
HG

3000 K 95°
870 Ix o
230 Ix 20-
105 Ix b

60 Ix Zéi

250 mm

500 mm

750 mm

1000 mm

|~o55--]

—hel~

Beleuchtungsstarke -10 % bei schwarzer Variante

Farbtemperatur
K

3000

Lichtfarbe

warmweil3

Lichtstrom
Im

120

|~-@55-~]|

Leistung
w

1,5

Héafele Loox LED 3034

P.MA

MASSMOBEL

> hohe Leichtgéngigkeit und Belastbarkeit fir den

Objektbereich

VVVYV

Demontage

mit einer USB-Ladestation 2,5 A

integrierter Druckschalter fur 2 Helligkeitsstufen
Farbtemperatur identisch mit Loox5 LED-Béndern
modulare Zuleitung erleichtert die Montage und

> Einsatzbereich:
> Ausflihrung:

Gehause Werkstoff:

Lange flexibler Arm:
Flexibler Arm

MaBe (& x L):

Lange:

Lebensdauer:
Energieeffizienzklasse:
Schutzart:

Montage:

V V. V V

V V.V V V

Hinweis

Flexibler Arm Werkstoff:

Leseleuchte

integrierte USB-Ladestation 5 V
/2,5 A, integrierter Druckschalter
fur 2 Helligkeitsstufen, mit mag-
netischer Abdeckung fiir Sockel
Aluminium

Aluminium

363 mm

36 x 363 mm

15 mm

L.80/B10 30000 h
G

1P20

zum Schrauben

Leistungsbedarf inklusive USB: 19 W, 20-W-Netzteil pro
Leuchte fir optimalen Betrieb der USB-Ladestation.
Modulare Zuleitung erleichtert die Montage und Demontage.

Montagehinweis

Beim Einsatz eines 6-fach-Verteilers mit Schaltfunktion oder
Hafele Connect Mesh bitte diese Leuchte mit integriertem
Schalter immer an den 7. Ausgang (Dauerstrom) des

6-fach-Verteilers anschlieBen.

passend zum Set sind im Lieferumfang enthalten:

LED 3034
Zuleitungen 2 m

v

2 m Einspeisleitung

ECO-Netzteil mit Schaltfunktion

inklusive Befestigungsmaterial

o
‘ﬁ ip20 O R\s?sa @

Lichtausbeute Farbe Artikel-Nr.
Im/W
80 verchromt 1er 833.86.267
2er 833.86.268
schwarz 1er 833.86.265
2er 833.86.266

P. Max. Licht im Mébel, N°3 2023
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Beleuchten — Punktlicht p. MA
Unterbauleuchten, monochrom MASSMOBEL

LED 1167

Unterbauleuchte, 24 V, monochrom, 5 W, optional mit Steckdose oder Ladestation

B e

> 2 Lichtfarben umschaltbar mit Hauptschalter oder Adapter
> Harmonisches Zusammenspiel von Beleuchtung und
Elektrifizierung

> dimmbar: ja

> Einsatzbereich: Kuchen, Schlafzimmer

> Gehause Werkstoff: Kunststoff

> Streuscheibe Werkstoff: Kunststoff

> Weitere Gehause- ringférmiger Lichtaustritt
merkmale:

> Stecker Bohrloch- 8 mm
durchmesser:

> Lebensdauer: 30000 h

> Farbwiedergabeindex Ra: 82-83

> Energieeffizienzklasse: G

> Montage: zum Schrauben

> Kabellange: 2000 mm

’ Hinweis
Leuchte Energieeffizienz
Dieses Produkt enthélt eine Lichtquelle der Energieeffizienzklas-
se G.

Leuchte: die Lichtfarbe ist durch Einsatz eines mitgelieferten
Adapters fest auf 2700 K oder fest auf 4000 K einstellbar.

Leuchte mit Hauptschalter und 6-fach-Verteiler: Die
Lichtfarbe der Leuchte mit Hauptschalter und aller Giber den
Verteiler angeschlossenen Leuchten ist Giber den Schalter

auf 2700 K oder 4000 K jederzeit umstellbar. Die Helligkeit ist
stufenlos von 5-100% dimmbar. Die Leuchte mit Hauptschalter
darf nur an Ausgange mit Dauerstrom angeschlossen werden.

Leuchte mit Schuko-Steckdose Leuchte mit Ladestation Leuchte mit Schuko-Steckdose: Max. Strombelastbarkeit

16 Al Die Installation, Inbetriebnahme und Wartung des Produkts
darf nur durch dafiir ausgebildete Elektrofachkrafte mit
entsprechender Qualifikation erfolgen.

Leuchte mit Ladestation: Die 2-fach USB-A-Ladestation
erfordert eine zusatzliche Leistung von 20 W und kann nur an
Ausgange mit Dauerstrom angeschlossen werden.

2700 K|4000 K 70°
Einsatz des 6-fach Verteilers Hafele Loox5 mit
ROl Brol: 2o SI0I0) Schaltfunktion oder Connect Mesh: Der Einsatz ist nur dann
o p— o - sinnvoll, wenn Leuchten ohne Hauptschalter verwendet werden.
ous In diesem Fall werden die Leuchten Uber den 6-fach-Verteiler
geschaltet und gedimmt.
Lieferumfang
1 Leuchte mit Zuleitung
Farbtemperatur Lichtfarbe Leistung Lichtstrom Lichtausbeute Ausfiihrung schwarz, stahlfarben,
K w Im Im/W Soft-Touch- lackiert
Effekt
2700-4000 warmwei | 5,0 350-400 70-80 Leuchte 833.32.040 | 833.32.050
oder Leuchte mit Hauptschalter 833.32.041  833.32.051
kaltweif (ein/aus, dimmen, Farbwechsel)
und 6-fach-Verteiler
mit Schuko-Steckdose 833.32.042 | 833.32.052
mit Ladestation 2 x USB-A je 5 A | 833.32.043 | 833.32.053

Abpackung: 1 Stlick

Bestellhinweis:
Netzteil separat bestellen, Seite 51



Beleuchten — Punktlicht
Spotleuchten, monochrom

Héfele Loox5 LED 3096

Unterbauleuchte, 24 V, 1,4 W, Durchmesser: 22 mm zur Eckmontage, IP20

®

P.MA

MASSMOBEL

> langlebige optische und mechanische Komponenten
> schmaler Abstrahlwinkel fur klare Akzentuierungen
> ausgestattet mit hochwertigen Samsung-LEDs

> dimmbar:
> Einsatzbereich:

> Gehause Werkstoff:
> Anzahl LEDs:

ja

fokussiertes Prasentationslicht fir
Objekte in Shops oder Museen
Aluminium

1

> Lebensdauer L80/B10: 50.000 h
> Schwenkbereich x-Achse: 55°
> Schwenkbereich y-Achse: 55°
> Farbwiedergabeindex Ra: >90
@.‘ - > Farbwiedergabeindex R9:  >70
> Montage: zum Kleben,
D zum Schrauben
|3000 K|4000 K|5000 K| 25°
T 1715 Ix 1825 Ix 1830 Ix i¢? 250mm  passend zum Set sind im Lieferumfang enthalten:
v
6151x 6601x 660 Ix Jok soomm > LED 3096
> Zuleitungen 2 m
> 2751x 2901Ix 290 Ix F S 750 mm
: > ECO-Netzteil mit Schaltfunktion
1551x 160 1x 165 Ix —j¢} 1000 mm > 2 m Einspeisleitung
> inklusive Befestigungsmaterial
UK
CA °@“s @ P20 S
Gehdausefarbe Farbtemperatur Lichtfarbe Lichtstrom Leistung  Lichtausbeute  Energie- Artikel-Nr.
effizienz-
K Im w Im/W klasse
silberfarben 3000 warmwei3 215 1,4 7 G Ter 833.86.272
2er 833.86.273
3er 833.86.274
der 833.86.361
4000 kaltweiB 225 1,4 84 F 1er 833.86.278
2er 833.86.279
3er 833.86.280
der 833.86.363
5000 kaltwei 125 1,4 89 HF 1er 833.86.284
2er 833.86.285
3er 833.86.286
der 833.86.365
schwarz matt 3000 warmweil 215 1,4 77 G 1er 833.86.269
2er 833.86.270
3er 833.86.271
4er 833.86.360
4000 kaltweiB 225 1,4 84 F 1er 833.86.275
2er 833.86.276
3er 833.86.277
der 833.86.362
5000 kaltweiB 125 1,4 89 HF 1er 833.86.281
2er 833.86.282
3er 833.86.283
der 833.86.364

P. Max. Licht im Mébel, N°3 2023
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Beleuchten — Punktlicht p. MA
Spotleuchten, monochrom MASSMOBEL

Héfele Loox5 LED 3097

Einbauleuchte, 24 V, 1,4 W, Bohrlochdurchmesser: 35 mm, IP20

®

> langlebige optische und mechanische Komponenten
> schmaler Abstrahlwinkel fur klare Akzentuierungen
> ausgestattet mit hochwertigen Samsung-LEDs

> dimmbar: ja
> Einsatzbereich: fokussiertes Prasentationslicht fir
Objekte in Shops oder Museen

> Gehause Werkstoff: Aluminium
> Anzahl LEDs: 1

> Lebensdauer L80/B10: 50.000 h

> Eigenschaften: schwenkbar
> Schwenkbereich y-Achse: 60°

> Farbwiedergabeindex Ra: >90

> Farbwiedergabeindex R9: >70

>
>

28, - 3000 K|4000 K|5000IK] 25 Montage: zum Einbohren und Klemmen
—= — | 17151x 1825 Ix 1830 250 mm Bohrloch-@: 35 mm
l* | — | 2 6151x 660Ix 660 Ix 500 mm
— - —_ passend zum Set sind im Lieferumfang enthalten:
o \\Ia«——l/ b osix 2001 200 20¢ 750 mm ~ LED 3097
;:;Z 1551x 1601x 165 Ix —j¢:— 1000 mm > Zuleitungen 2 m
> ECO-Netzteil mit Schaltfunktion
> 2 m Einspeisleitung
> inklusive Befestigungsmaterial
UK
cA "@“S @ P20 ﬁ
Gehausefarbe Farbtemperatur | Lichtfarbe Lichtstrom Leistung Lichtausbeute Energie- Artikel-Nr.
effizienz-
K Im w Im/W klasse
silberfarben 3000 warmweil3 108 1,4 77 HG ler 833.86.290
2er 833.86.291
‘ 3er 833.86.292
[ a ) der  833.86.367
© 4000 kaltwei 118 1,4 84 [3 1er 833.86.296
2er 833.86.297
3er 833.86.298
der 833.86.369
5000 kaltweil 125 1,4 89 [3 1er 833.86.302
2er 833.86.303
3er 833.86.304
der 833.86.371
schwarz matt 3000 warmweiB 108 1,4 77 HaG Ter 833.86.287
2er 833.86.288
3er 833.86.289
der 833.86.366
4000 kaltweiB 118 1,4 84 G 1er 833.86.293
2er 833.86.294
3er 833.86.295
der 833.86.368
5000 kaltwei 125 1,4 89 3 1er 833.86.299
2er 833.86.300
3er 833.86.301
der 833.86.370




Beleuchten — Punktlicht p. MA
Spotleuchten, monochrom MASSMOBEL

Héfele Loox5 LED 3098

Unterbauleuchte, 24 V, 1,4 W, Durchmesser: 22 mm, IP20

®

> langlebige optische und mechanische Komponenten
> schmaler Abstrahlwinkel fur klare Akzentuierungen
> ausgestattet mit hochwertigen Samsung-LEDs

> dimmbar: ja
> Einsatzbereich: fokussiertes Prasentationslicht fir
Objekte in Shops oder Museen
> Gehause Werkstoff: Aluminium
> Anzahl LEDs: 1
> Lebensdauer L80/B10: 50.000 h
> Durchmesser: 22 mm
> Hohe: 26 mm
> Farbwiedergabeindex Ra: >90
28 > Farbwiedergabeindex R9: >70
|l |3000 K|4000 K|5000 K| 25° > Montage: zum Schrauben
‘ e ‘ 1715 Ix 1825 Ix 1830 Ix Sof 250 mm
T T passend zum Set sind im Lieferumfang enthalten:
E 6151x 660 Ix 660 Ix =0z 500mm o | ED 3098
al 2751x 2901x 290 Ix 0= 750mm > Zuleitungen 2 m
#12.5 *L » > ECO-Netzteil mit Schaltfunktion
- @22 1551x 160 Ix 165 Ix -0- 1000 mm > 2 m Einspeisleitung
> inklusive Befestigungsmaterial
UK
cA "@“S @ P20 ﬁ
Gehausefarbe Farbtemperatur | Lichtfarbe Lichtstrom Leistung Lichtausbeute Energie- Artikel-Nr.
effizienz-
K Im w Im/W klasse
silberfarben 3000 warmweil3 108 1,4 77 HG 1er 833.86.308
2er 833.86.309
3er 833.86.310
4er 833.86.373
4000 kaltweiB 118 1,4 84 [3 1er 833.86.314
2er 833.86.315
3er 833.86.316
4er 833.86.375
5000 kaltweiB 125 1,4 89 [3 1er 833.86.320
2er 833.86.321
3er 833.86.322
4er 833.86.377
schwarz matt 3000 warmweiB 108 1,4 77 HG Ter 833.86.305
2er 833.86.306
3er 833.86.307
der 833.86.372
4000 kaltweiB 118 1,4 84 G 1er 833.86.311 o
[aY]
2er 833.86.312 8
3er  833.86.313 i
4er 833.86.374 f':;
5000 kaltweiB 125 1,4 89 F 1er 833.86.320 g
2er 833.86.321 E
3er  833.86.322 §
4er 833.86.377 é
=
o



P. Max. Licht im M&bel, N°3 2023

Beleuchten — Punktlicht p. M A
Anbauleuchten, monochrom MASSMOBEL

LED 1190

Anbauleuchten-Set, stabférmig IP44

oD O

> hochwertige Ausfiihrung, made in Austria

> spritzwassergeschtzt fir den Einsatz in Feuchtrdumen
> Setverpackung inkl. Netzteil

> Kaltweil3 4000

> dimmbar: ja
> Einsatzbereich: Spiegel und Schrankbeleuchtung
> Ausfuihrung: Lichtaustritt an zwei Seiten
> Werkstoff: Gehause: Aluminium
Blende: Kunststoff
> Oberflache: natur-eloxiert
> Bandbreite: 8 mm
> Energieeffizienzklasse: F
> Schutzart: P44
> Montage: zum Anschrauben
E_ Bestellhinweis:
,'.':i > Schalter separat bestellen (ab Seite 32)

passend zum Set sind im Lieferumfang enthalten:
; > LED 1190
% - > Zuleitungen
> Netzteil mit 2 m Einspeisleitung
> Verteiler mit Schaltfunktion

==

gT

Bandlange mm

280| 380| 480| 580| 780 980] 1180| 1380|1580 120°
X 1878 2510 2988 3425 3572 3758 3816 3874 3938 250 mm
§ 548 745 931 1157 1357 1615 1695 1780 1802 500 mm
270 380 483 601 748 905 1021 1125 1151 750 mm
164 227 290 364 474 586 674 748 782 1000 mm
S IP44 @ "“s
Farbtemperatur Lichtfarbe Lichtstrom Leistung/m Liange Artikel-Nr.
K Im/m w mm
4000 kaltweiB 513 4,8 280 833.88.039
718 6,7 380 833.88.040
923 8,6 480 833.88.041
1128 10,6 580 833.88.042
1538 14,4 780 833.88.043
1948 18,2 980 833.88.044
2358 22,1 1180 833.88.045
2768 25,9 1380 833.88.046
3178 29,8 1580 833.88.047

Abpackung: 1 Set

|
~J



Beleuchten — Punktlicht
Ein-/Unterbauleuchten, modular, multi-weif3 P. Msﬁmxﬂ

Héafele Loox5 LED 3091

Einbauleuchte 24 V, multi-weiB, 3,4 W, Bohrlochdurchmesser: 58 mm, IP45

Bl . @D

> ausgestattet mit hochwertigen Samsung-LEDs

> modulares System: freie Gestaltungsmdglichkeiten mit
wechselbaren Gehdusen und Zuleitungen

> Leuchte mit integrierter Kabelbuchse flr schnelles
Umrlsten

> hohe Lichtausbeute

> dimmbar: ja

> Einsatzbereich: Arbeitsplatzbeleuchtung,
Kichen- und Wohnmaobel,
Theken

> Gehause Werkstoff: Aluminium
> Anzahl LEDs: 12

> Lebensdauer: 50000 h

> Farbwiedergabeindex Ra:  >90

> Farbwiedergabeindex R9: >55

>
>

Energieeffizienzklasse: B
Montage: zum Einbohren und Klemmen
oder zum Schrauben
> Bohrlochdurchmesser: 58 mm

Hinweis

Die Schutzart IP45 verringert sich bei Verwendung eines
Unterbaugehaduses auf IP20.

Bestellhinweis:

Schalter separat bestellen (ab Seite 32)

Immer erforderlich: % passend zum Set sind im Lieferumfang enthalten:
® Leuchtenmodul, @ Gehduse, @ Zuleitung > LED 3091 mit Einbau- oder Unterbauring
> Zuleitungen

12700 K15000 K| ‘ > Netzteil mit 2 m Einspeisleitung
> Verteiler mit Schaltfunktion

2000 Ix 2100 Ix + 250 mm

520Ix 550 Ix 1 500 mm +X% "‘@

r 750 mm

KYSN BSY)
S BN

2201x 2351x

L
s
I

v/
S

120 Ix 125 Ix +1000 mm

¥ IP20

—%\PS t P45 @ @“s

O Installationsregeln in Badezimmern » Seite 4
im Wohnbereich

P. Max. Licht im Mébel, N°3 2023
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Beleuchten — Punktlicht
Ein-/Unterbauleuchten, modular, multi-weiB P. Msﬁssa

Héfele Loox5 LED 3091

Farbe Set Artikel-Nr. Farbe Set Artikel-Nr.
Hafele Loox5 LED 3091 - Einbauleuchte Héafele Loox5 LED 3091 - Unterbauleuchte
edelstahlfarben 2er 833.ge.3p7  Cdelstanifarben 2er 833.86.339
‘ﬂ%‘ 3er 833.86.328 3er 833.86.340
(} ‘> der 833.86.329 der 833.86.341
schwarz 2er 833.86.330 Sowarz 2er 833.86.342
3er 833.86.331 3er 833.86.343

0

4er 833.86.332 4er 833.86.344

edelstahlfarben 2er 833.86.333  edelstahlfarben 2er 833.86.345

3er 833.86.334 3er 833.86.346

3

4er 833.86.335 4er 833.86.347

schwarz 2er 833.86.336  Schwarz 2er 833.86.348
w 3er 833.86.337 3er 833.86.349
der 833.86.338 der 833.86.350
28/09* 28/09*
©08/09* 08/@9* = | |
ovor - osor | f
+ B i |3 * M 1
T T T T e e
w.T -~ os8 \‘ w.T ‘\ 058 \‘ T - T -
o 265 o [ @65 es5
Einbaumontage rund Einbaumontage quadratisch Unterbaumontage rund Unterbaumontage quadratisch



Beleuchten — Punktlicht
Ein-/Unterbauleuchten, multi-weif3 P. Msﬁmxﬂ

Héfele Loox5 LED 3039

Einbauleuchte 24 V, multi-wei3, 3 W, Bohrlochdurchmesser: 55 mm

5 2« IR G 2

> Lichtfarbe stufenlos einstellbar von warmweiB bis
kaltwei
> hochwertiges Metallgehduse

> dimmbar: ja

> Einsatzbereich: als Ambientebeleuchtung in
Mébeln

> Gehduse Werkstoff: Stahl

> Anzahl LEDs: 60

> Lebensdauer: 30000 h

> Farbwiedergabeindex Ra:  83-90

> Energieeffizienzklasse: G

> Montage: zum Einbohren und Klemmen

> Bohrlochdurchmesser: 55 mm

passend zum Set sind im Lieferumfang enthalten:
> LED 3039 mit Einbauring

wf > Zuleitungen
o 65 ‘ > Netzteil mit 2 m Einspeisleitung
Einbaumontage > Verteiler multi-weiB mit Schaltfunktion
2700 K| 5000 K 120°
3351x 350 Ix 0- 250 mm
1251x 130 Ix ::: 500 mm
701x  70Ix > 750 mm
451x 451 ) 1000 mm
% 25 1p2o O L @
Gehausefarbe Farbtemperatur Lichtfarbe Lichtstrom Leistung | Lichtausbeute Farbwieder- Artikel-Nr.
gabeindex
K Im w Im/W Ra
edelstahlfarben 2700-5000 multiwei 258 3 85 83-90 2er 833.86.351
3er 833.86.352
4er 833.86.353
silberfarben 2700-5000 multiwei 258 3 85 83-90 2er 833.86.354
3er 833.86.355
4er 833.86.356
verchromt, poliert | 2700-5000 multiwei 258 3 85 83-90 2er 833.86.357
/"- “\\ 3er 833.86.358
( — ) 4er 833.86.359

P. Max. Licht im Mébel, N°3 2023



Beleuchten — Punktlicht
Anbauleuchten, multi-weif3

LED 1191

Anbauleuchten-Set, stabférmig IP44

B e ©

P.MA

MASSMOBEL

> hochwertige Ausfiihrung, made in Austria
> spritzwassergeschitzt fir den Einsatz in Feuchtrdumen

> Setverpackung inkl. Netzteil
> MulitweiB-LED 2700-5000 K
> Ansteuerung Uber Hafele Connect-MESH-App. oder

Fernbedienung

> dimmbar:

> Einsatzbereich:
> Ausflhrung:

> Werkstoff:

> Oberflache:

> Bandbreite:

> Energieeffizienzklasse:
> Schutzart:

> Montage:

ja
Spiegel und Schrankbeleuchtung
Lichtaustritt an zwei Seiten

Gehause: Aluminium
Blende: Kunststoff

natur-eloxiert

8 mm

F

P44

zum Anschrauben

passend zum Set sind im Lieferumfang enthalten:

> LED 1191
> Zuleitungen

> Netzteil mit 2 m Einspeisleitung
> Verteiler multi-weiB mit Schaltfunktion

Bandlange mm

280| 380] 480| 580| 780| 980]1180|1380| 1580]

Ix /5000 K

209 296 367 444 572 652 750 814 871

126 177 224 270 357 412 490

Leistung/m
w

3,6
5,0
6,5
7,9
10,8
13,7
16,6
19,4
22,3

1571 2014 2214 2425 2699 2825 2844 2882 2905

427 582 714 837 1038 1159 1244 1295 1374

120°
250 mm
500 mm
750 mm
548 593 1000 mm
S pas O @
Lange Artikel-Nr.
mm
280 833.88.048
380 833.88.049
480 833.88.050
580 833.88.051
780 833.88.052
980 833.88.053
1180 833.88.054
1380 833.88.055
1580 833.88.056

= =
| |
‘ i B “ ¥
| |
= s
3 20|30 !
i
* :
3
Bandlange mm
280| 380| 480| 580| 780| 980] 1180| 1380|1580 120°
X 905 1154 1267 1393 1542 1593 1608 1622 1647 250 mm
o
~
E 246 334 409 479 594 675 708 728 757 500 mm
121 170 210 254 327 382 428 457 480 750 mm
73 101 127 155 205 245 281 309 327 1000 mm
Farbtemperatur Lichtfarbe Lichtstrom Lichtstrom
K 2700 K Im/m 5000 K Im/m
- 2700-5000 warmweil 308 342,5
cg\l kaltweiB 431 4795
™ 554 616,5
P4 677 758, /5
g‘ 923 1027,5
§ 1169 1301,5
E 1415 1575,5
% 1661 1849,5
:! 1907 2123,5
g Abpackung: 1 Set
o



Schalten und Steuern
Sensorschalter

Sensorschalter Hafele Loox, modular

P.MAX

MASSMOBEL

™ )
e )
o i S |=—46
\.,-_:'F\ > = 1
!
,f*"'/ 1|05

> Schaltfunktion:

> Werkstoff:
> Sensorreichweite:
> Leistung:
> Schutzart:
> Montage:

> Bohrlochdurchmesser:

> MaBe (@ x L):

Farbe/
Oberflache

silberfarben
schwarz
weil

ein/aus sanft berlihrungslos,
mit Memory-Funktion fur
Ein/Aus-Zustand bei stromlos

Kunststoff
0-80 mm
0,3W
IP20

zum Einbohren oder
zum Einstecken in Gehause

12 mm
13,5 x 46 mm
IP20
Abpackung Artikel-Nr.
Stiick
1 oder 50 833.89.127
K 1833.89.167
|1 1833.89.169

Bestellhinweis

Zuleitung mit Einrastverbinder flir modulare Schalter bitte
separat bestellen. Lange 2 m: Artikel-Nr. 833.89.142

Tur-Sensorschalter Hafele Loox, modular

™ 0
o o
_ e SL —l
- 4
LT F.‘f_f,-"'ﬂ
!
= 1|05

> Schaltfunktion:

> Werkstoff:
> Sensorreichweite:
> Leistung:
> Schutzart:
> Montage:

> Bohrlochdurchmesser:

> MaBe (@ x L):

Farbe/
Oberflache

silberfarben
schwarz
weil

ein/aus sanft
Tar auf = Licht an,
Tlr zu = Licht aus

Kunststoff
0-100 mm
0,3W
1P20

zum Einbohren oder
zum Einstecken in Gehause

12 mm
13,5 x 46 mm
IP20
Abpackung Artikel-Nr.
Stiick
1 oder 50 833.89.128
K 1833.89.170
K 1833.89.171

Bestellhinweis

Zuleitung mit Einrastverbinder fiir modulare Schalter bitte
separat bestellen. Lange 2 m: Artikel-Nr. 833.89.142

Montgehinweis:

Bitte beachten Sie die vorgegebene Einsteck-Ausrichtung, beigepackten Reflektor fiir einwandfreie Funktion verwenden.

O Zuleitung, Hafele Loox fur modulare Schalter » Seite 39

O Gehause flr Schalter Hafele Loox » Seite 34

P. Max. Licht im Mébel, N°3 2023
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Schalten und Steuern P.MA
Sensorschalter MASSMOBEL

Bewegungsmelder Hafele Loox, modular

> Schaltfunktion: ein/aus automatisch
> Werkstoff: Kunststoff
> Sensorreichweite: 0-3000 mm
> Sensorwinkel: 120°
> Leistung: 0,1 W
P 0 . > Schutzart: IP20
L 2 ‘ji?i > Montage: zum Einbohren oder
e > 1 | zum Einstecken in Gehause
. ' m% > Bohrlochdurchmesser: 12 mm

\"

A7 Y ) MaBe (@ x L): 13,5 x 56 mm

Montgehinweis:
Bitte beachten Sie die vorgegebene Einsteck-Ausrichtung.

IP20
Farbe/ Nachlaufzeit ‘ Abpackung ‘ Preis /
Oberfliche s Stiick 100 ME
silberfarben 30 ‘1oder50  833.89.129
silberfarben 320 K 1833.89.148
schwarz 130 K 1833.89.172
weiB 30 |1 1833.89.173

Bestellhinweis
Zuleitung mit Einrastverbinder fir modulare Schalter bitte
separat bestellen. Lange 2 m: Artikel-Nr. 833.89.142

Dimmer Héfele Loox, modular, ein/aus sanft

> Schaltfunktion: ein/aus sanft,
dimmen (mit Memory-Funktion)
> Werkstoff: Kunststoff
> Leistung: 0,3 W
> Schutzart: 1P20
zum Berlhren > Montage: zum Einbohren oder
zum Einstecken in Gehause
) © > Bohrlochdurchmesser: 12 mm
g 46 ‘ g > MaBe (@ x L): 13,5 x 46 mm
= L |
Ties A IP20
Schaltkontakt  Farbe/ Abpackung Preis/
Oberfliche  Stiick 100 ME
mit Berlihrung silberfarben 1 oder 50 833.89.058
schwarz 1 833.89.174
weil 1 833.89.175
berthrungslos silberfarben 1 oder 50 833.89.126
schwarz 1 833.89.166
weil 1 833.89.168

Bestellhinweis
Zuleitung mit Einrastverbinder fir modulare Schalter bitte
separat bestellen. Ladnge 2 m: Artikel-Nr. 833.89.142

O Zuleitung, Hafele Loox fur modulare Schalter » Seite 39
O Gehause flr Schalter Hafele Loox » Seite 34




Schalten und Steuern p M Ax
Sensorschalter ® MASSMOBEL

Gehause fiir Schalter Hafele Loox

e 3
1

L ) -

> fir Raster 32 geeignet A

> Werkstoff: Kunststoff
1 > verwendbar flr: Schalter @ 12 mm
- i > MaBe (L x B x H): 48 x 45 x 17 mm

LT > MaBe (@ x H): 16 x 17 mm

b > Montage: zum Schrauben
Lieferumfang
1 Gehause
Farbe/Oberflache Artikel-Nr.
silberfarben 833.89.090

Abpackung: 1 oder 100 Stlick

Gehause fiir Schalter Hafele Loox

> flr Raster 32 geeignet A

> Werkstoff: Kunststoff

> verwendbar flr: Schalter @ 12 mm
> Montage: zum Schrauben

> MaBe (L x B x H): 48 x 16 x 17,1 mm
> MaBe (@ x H): 14 x17,1 mm
Hinweis

Befestigungsplatte schrauben, Gehduse aufschieben

Farbe/ Abpackung Artikel-Nr.
Oberflache Stiick

silberfarben 1 oder 50 833.89.092
schwarz K 1833.89.163
weiB K 1 833.89.165

P. Max. Licht im Mébel, N°3 2023
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Schalten und Steuern P.MA
Sensorschalter MASSMOBEL

Sensorschalter Hafele Loox, modular

> Schaltfunktion: ein/aus sanft berlihrungslos,
mit Memory-Funktion flr
Ein/Aus-Zustand bei stromlos

> Werkstoff: Kunststoff
> Sensorreichweite: 0-80 mm
> Leistung: 0,3W
> Schutzart: IP20
> Montage: zum Kleben
zum Schrauben
> MaBe (L x B x H): 40 x 40 x 8,5 mm

Lieferumfang
1 Schalter inkl. Befestigungsmaterial

=40~ ~|s.5/~

IP20
Farbe/ Abpackung Artikel-Nr.
Oberflache Stiick
silberfarben 1 oder 50 1833.89.136
schwarz K 1833.89.180
weiB K 1833.89.181

Bestellhinweis
Zuleitung mit Einrastverbinder fiir modulare Schalter bitte
separat bestellen. Lange 2 m: Artikel-Nr. 833.89.142

@ Zuleitung, Hafele Loox flir modulare Schalter B Seite 37




Schalten und Steuern P. MA

Sensorschalter MASSMOBEL
> Schaltfunktion: ein/aus sanft
> Werkstoff: Kunststoff
> Sensorreichweite: 0-100 mm
> Leistung: 0,3W
> Schutzart: IP20
> Montage: zum Kleben
zum Schrauben
> MaBe (L x B x H): 40 x 40 x 8,5 mm

Lieferumfang
1 Schalter inkl. Befestigungsmaterial

IP20
40—~ 8.5/~ Farbe/ Abpackung Artikel-Nr.
Oberflache Stiick
silberfarben 1 oder 50 1 833.89.137
schwarz K 1833.80.182
weiB |1 1833.89.183

Bestellhinweis
Zuleitung mit Einrastverbinder fiir modulare Schalter bitte
separat bestellen. Ladnge 2 m: Artikel-Nr. 833.89.142

Dimmer Héfele Loox, modular

> Schaltfunktion: ein/aus sanft,
dimmen (mit Memory-Funktion)
> Werkstoff: Kunststoff
> Leistung: 0,3 W
> Schutzart: IP20
> Montage: zum Kleben
zum Schrauben
> MaBe (L x B x H): 40 x 40 x 8,5 mm

Lieferumfang
1 Schalter inkl. Befestigungsmaterial

IP20

Schaltkontakt  Farbe/ Abpackung  Preis /

Oberflaiche  Stiick 100 ME
mit Berlihrung silberfarben 1 oder 50 833.89.134
@ . - schwarz 1 833.89.176
e Lo weil 1 833.89.177
\ \ beriihrungslos silberfarben 1 oder 50 833.89.135
schwarz 1 833.89.178
weif 1 833.89.179

Bestellhinweis
Zuleitung mit Einrastverbinder fir modulare Schalter bitte
separat bestellen. Ladnge 2 m: Artikel-Nr. 833.89.142

L]

~ 40—~ 8.5/~ 40—~ ~lg.5/~

zum Berthren berlihrungslos

@ Zuleitung, Hafele Loox fir modulare Schalter B Seite 37
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Schalten und Steuern p. M A
mechanische Schalter MASSMOBEL

Modularer Universal-Turkontaktschalter

> Einsatzbereich: fiir einfliigelige Schiebetir oder
Drehtur
> Werkstoff: Kunststoff
> Schutzart: IP20
> Montage: zum Schrauben
> MaBe (L x B x H): 51,8 x40 x 14,2 mm
1 1P20
( N4 7 = Farbe/Oberflache Artikel-Nr.
T schwarz 1 833.89.143

ogle a2 | 24

40—

Abpackung: 1 oder 50 Stiick
Bestellhinweis

Zuleitung mit Einrastverbinder fiir modulare Schalter bitte
separat bestellen. Lange 2 m: Artikel-Nr. 833.89.142

Zuleitung, Hafele Loox

fiir modulare Schalter

> Einsatzbereich: fUr modulare Schalter
> Ausflihrung: mit Einrastverbinder
> Werkstoff: Kunststoff

> Stecker Bohrloch@: 12 mm

Hinweis

Die maximale Leitungslange eines Schalters betragt 6 m

Lieferumfang
1 Zuleitung Stecker/modularer Stecker

\

IP20
Eingénge ‘ Ausgénge ‘ Kabelldnge mm ‘ Artikel-Nr.
1 x Stecker, Loox modular mit Raster \ 1 x Stecker, Loox Schalter \ 500 \ 833.89.140
\ 11000 833.89.141
\ 12000 833.89.142
Abpackung: 1, 10 oder 80 Stick
Bestellhinweis
Verlangerungsleitung 833.89.067 bitte separat bestellen.
Turkontaktschalter Hafele Loox
Schaltfunktion Tiir auf = Licht an, Tiir zu = Licht aus
| 28 % > Einsatzbereich: zum Schalten mittels Tir 6ffnen
u‘, a — bzw. Tur schlieBen, auch fdr
L grifflose Fronten mit Offnungs-
;F il unterstlitzung geeignet
> Schaltfunktion: Tur auf = Licht an,
Tlr zu = Licht aus
> Werkstoff: Kunststoff
> Schutzart: IP20
> Montage: zum Einbohren
> Bohrlochdurchmesser: 12 mm
> Kabellange: 2000 mm
> Stecker Bohrloch-@: 12 mm
> MaBe (@ x L): 15 x 28 mm
Lieferumfang
1 Schalter mit 2 m Zuleitung IP20
Schaltkontakt 'Farbe/Oberfliche  Preis / 100 ME

mit Berlihrung \ schwarz \ 833.89.059
Abpackung: 1 oder 50 Stiick




Schalten und Steuern
mechanische Schalter

Schaltfunktion ein/aus

Wippschalter Hafele Loox

Druckschalter Hafele Loox

> Schaltfunktion:

> Werkstoff:

> Schutzart:

> Bohrlochdurchmesser:
> Kabellange:

> Stecker Bohrloch-
durchmesser:

> MaBe (@ x L):
Lieferumfang

1 Schalter mit 2 m Zuleitung
Farbe/Oberflache

schwarz
grau
Abpackung: 1 oder 50 Stiick

P.MAX

MASSMOBEL

Schaltfunktion ein/aus

H_L@15 ’*

-
-
S
[
b

FuBschalter Hafele Loox

> Schaltfunktion:

> Werkstoff:

> Schutzart:

> Bohrlochdurchmesser:
> Kabellange:

> Stecker Bohrloch-
durchmesser:

> MaBe (@ x L):
Lieferumfang
1 Schalter mit 2 m Zuleitung

Farbe/Oberflache
schwarz

ein/aus

Kunststoff

IP20

12 mm

2000 mm

12 mm

15 x 20 mm
IP20
Artikel-Nr.
833.89.108
833.89.107

ein/aus

Kunststoff

IP20

12 mm

2000 mm

12 mm

15 x 17,7 mm
IP20
Artikel-Nr.
833.89.106

Abpackung: 1 oder 50 Stiick

Schaltfunktion ein/aus

i

8

> Einsatzbereich:

zum Schalten von LED-Leuchten

mit dem FuB
L ~—2000 »‘ . .
(%4 ,.'_FEI > Schaltfunktion: ein/aus

[=]
o i > Werkstoff: Kunststoff
ﬁ @70 ‘ > Schutzart: 1P20
> Kabellange: 2000 mm
> Stecker Bohrloch- 12 mm
durchmesser:
> MaBe (J x H): 70 x 28 mm

Lieferumfang
1 Schalter mit 2 m Zuleitung

Farbe/Oberflache
schwarz

IP20

Artikel-Nr.
833.89.046

Abpackung: 1 oder 50 Stiick

P. Max. Licht im Mébel, N°3 2023
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Schalten und Steuern p. M A
mechanische Schalter MASSMOBEL

Zuleitung, Héafele Loox

fiir modulare Schalter

> Einsatzbereich: fiir modulare Schalter

> Ausflihrung: mit Einrastverbinder

> Werkstoff: Kunststoff

> Stecker Bohrloch@: 12 mm

Hinweis

Die maximale Leitungslange eines Schalters betragt 6 m
Lieferumfang

1 Zuleitung Stecker/modularer Stecker

IP20
Eingdnge ‘ Ausgénge ‘ Kabelldnge mm ‘ Artikel-Nr.
1 x Stecker, Loox modular mit Raster ‘ 1 x Stecker, Loox Schalter ‘ 500 ‘ 833.89.140
\ 11000 1 833.89.141
\ 12000 1 833.89.142
Abpackung: 1, 10 oder 80 Stlick
Zuleitung, Héfele Loox
fiir Multi-Netzteil-Box und Multi-Schalter-Box
> Werkstoff: Kunststoff
> Stecker Bohrloch- 12 mm
durchmesser:
Hinweis
Alternative zur mitgelieferten 1-m-Leitung der
Multi-Schalter-Box.
Lieferumfang
1 Zuleitung Stecker/Stecker
IP20
Eingange Ausgange Kabellange Preis /
mm 100 ME
1 x Stecker, 1 x Stecker, 500 833.89.068
Loox Schalter | Loox Schalter | 2ggo 833.89.069

Abpackung: 1 oder 12 Stiick

Verléangerungsleitung, Hafele Loox

fiir Schalter und modulare Schalter

> Werkstoff: Kunststoff

> Stecker Bohrloch- 12 mm
durchmesser:

> Buchse Bohrloch- 12 mm
durchmesser:

> Kabellange: 2000 mm

Hinweis

Geeignet zur Verlangerung aller Hafele Loox Schalterzuleitungen
(integrierte Zuleitungen, modulare Zuleitungen mit und ohne Ein-
rastverbinder, Zuleitungen fir Multi-Schalter-Box).

max. Leitungslange vom Netzteil bis zum Schalter: 6 m.

Lieferumfang
1 Verlangerungsleitung Stecker/Buchse

IP20
Eingange Ausgange Artikel-Nr.
1 x Buchse, 1 x Stecker, 833.89.067

Loox Schalter Loox Schalter
Abpackung: 1 oder 12 Stiick




Schalten und Steuern p M Ax
Sensorschalter ® MASSMOBEL

> Einsatzbereich: fur monochrome Loox5-
LED-Bander 8 mm in
Loox-Aluminiumprofilen
1190, 1191, 2190, 2191

> Schaltfunktion: ein/aus sanft,
dimmen (mit Memory-Funktion)

> Werkstoff: Kunststoff
> Montage: zum Eindriicken
> Stecker Bohrlochdurch- 8 mm

messer:
> Kabellange: 2000 mm
> MaBe (L x B x H): 36 x 17 x 7,7 mm

Lieferumfang
1 Schalter mit Clip/Stecker mit 2-m-Zuleitung

Montagehinweis
Die Streuscheibe muss bauseits um 36 mm gekiirzt werden.

7 T =1
SUDTR J ot NV A P
17 4 21.5 1 16 36—={=—2000——| 19
‘Eingénge ‘geschaltete Ausgange Leistung ‘Farbe/Oberfléiche ‘ArtikeI-Nr.
w

1 x Stecker, 1 x Clip, 90
Loox5 2-pol. 24 V Loox5 Band 8 mm monochrom

Abpackung: 1 Stlick

silberfarben ‘ 833.77.836

Bewegungsmelder fiir Aluminiumprofil Hafele Loox5, ein/aus automatisch

> Einsatzbereich: fur monochrome Loox5-
LED-Bander 8 mm in
Loox-Aluminiumprofilen
1190, 1191, 2190, 2191

> Schaltfunktion: ein/aus automatisch
> Werkstoff: Kunststoff
> Sensorreichweite: 0-3000 mm
> Nachlaufzeit: 30s
> Montage: zum Eindriicken
> Stecker Bohrlochdurch- 8 mm
messer:
> Kabellange: 2000 mm
> MaBe (L x B x H): 36 x 17 x 15 mm

Lieferumfang
1 Schalter mit Clip/Stecker mit 2-m-Zuleitung

nﬁ"‘
f g —

el oo

+ *‘ 17 ‘* - 21.5 + 16 L*SG—» 2000— 19 ‘*

Montagehinweis
Die Streuscheibe muss bauseits um 36 mm gekiirzt werden.

)

‘ Eingdnge geschaltete Ausgédnge Leistung ‘ Farbe/Oberflache ‘ArtikeI-Nr.
W
1 x Stecker, 1 x Clip, 90 silberfarben 833.77.835
Loox5 2-pol. 24 V Loox5 Band 8 mm monochrom

Abpackung: 1 Stlick

O passende Unterbauprofile, Hafele Loox, » Seite 9-10
Profil 2190, 2191

P. Max. Licht im Mébel, N°3 2023
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Schalten und Steuern
Schnittstellen p’ MSABEL

Dimmer-Schnittstelle, modular, Hafele Loox, 1-10 V

fiir 12V und 24 V Systeme

> Wanddimmer im Design der Hausinstallation flr die
Steuerung von Moébelleuchten nutzen
> fir Dimmer mit 1-10 V-Steuerausgang

> Einsatzbereich: zum Dimmen von Leuchten an
einem Loox-Netzteil 12 V oder
24V mit einem Wanddimmer
mit Ein-/Aus-Funktion und
Steuerausgang 1-10 V

> Ausflihrung: fur Zuleitung mit Einrastverbinder
> Steuereingénge: Direktanschluss zum Schrauben
> Steuerausgange: 1 x Buchse, Loox Schalter
modular mit Raster
> Werkstoff: Kunststoff
> Farbe/Oberflache: schwarz
Anschlussschema Loox5: > MaBe (L x B x H): 69 x 35 x 13,5 mm
Dimmer-Schnittstelle und > Schutzart: IP20
Wand-/M&bel-Dimmer mit Hinweis
1-10-V-Ausgang Dimmer nur verwenden, wenn monochrome Leuchten
Kein Anschluss des angeschlossen werden. Keine Steuergerate oder Konverter an-
Dimmers an Netzspannung! schlieBen.

Direktanschluss an einen haushaltstiblichen Dimmer mit 1-10 V
Steuerausgang und Anschluss Uber Zuleitung mit Einrastver-
binder flr modulare Schalter an Schaltereingang eines Loox
Netzteils 12 V, 24 V bzw. eines Verteilers.

IP20
Produkttyp Artikel-Nr.
Dimmer-Schnittstelle, modular \ 833.89.144

Abpackung: 1 oder 50 Stiick

Bestellhinweis
Zuleitung mit Einrastverbinder fiir modulare Schalter bitte
separat bestellen. Lange 2 m: Artikel-Nr. 833.89.142

Montagehinweis

Dimmer (z. B. Gira 030800 oder 030900) und Hohlwanddose
Dimmer-Schnittstelle und Kopplung von bauseits.

Multi-Netzteil-Boxen

® Dimmer-Schnittstelle

Multi-Netzteil-Box

Nicht mit Multi-Schalter-Box kombinierbar

Anschlussschema Loox5



Schalten und Steuern
Sensorschalter

Multi-Netzteil-Box Hafele Loox

fiir Multi-Netzteil-Box und Multi-Schalter-Box

Kaskade aus 2 Multi-Netzteil-Boxen flir max. 5 Netzteile/Verteiler
mit Schaltfunktion:

©®

Anschlussschema Loox5
A: Schalter
B: Multi-Schalter-Box

Anschlussschema Loox5:

Kaskade aus 2 Multi-Netzteil-Boxen flir max. 5 Netzteile/
Verteiler mit Schaltfunktion.

® Dimmer-Schnittstelle

Multi-Netzteil-Box
Nicht mit Multi-Schalter-Box kombinierbar

@® Schalter
Multi-Schalter-Box
© Netzteil
© Multi-Netzteil-Box

Nicht mit Loox-Dimm-
Schalter kombinierbar

Anschlussschema Loox5:
Kombination von Multi-Schalter-Box
und Multi-Netzteil-Box

P.MA

MASSMOBEL

> Mit 1 Schalter bis zu 3 LED-Netzteile verschiedener
Spannung bzw. Verteiler mit Schaltfunktion schalten.

> Es kdnnen so mit einem Schalter mehrere Leuchten
im Raum ein- und ausgeschaltet werden. Es kdnnen
auch 3 gleiche Spannungssysteme angeschlossen
werden, sollten Sie z. B. im 12-V-System mehr
Leistung benétigen.

> Funktionsweise: Zum Schalten von bis zu
3 Netzteilen mit einem Schalter
Kombinieren von verschiedenen
Systemen mdoglich

12V, 24V)
Schaltleistung 3 x 90 W
> Werkstoff: Kunststoff
> Farbe/Oberflache: schwarz
> Steuereingénge: 3 x Stecker, Loox Schalter
> Steuerausgange: 1 x Buchse, Loox Schalter
> MaBe (L x B x H): 50 x 40 x 19 mm
> Stecker Bohrloch- 12 mm
durchmesser:
> Kabellange: 1000 mm
Hinweis

6 m max. Leitungslédnge vom Netzteil bis zum Schalter.
Durch Kaskadieren von 2 Multi-Netzteil-Boxen ist das Schalten
von bis zu 5 Netzteilen/Verteilern mit einem Schalter méglich.

Lieferumfang
1 Netzteil-Box mit Befestigungsmaterial
3 Zuleitungen fiir Schalter je 1 m

Standby-Leistungsverbrauch Artikel-Nr.
w
1,5 | 833.89.061

Abpackung: 1 oder 30 Stiick

Bestellhinweis
Zuleitung fur Schalter Seite 39 in anderen Langen bitte separat
bestellen.

P. Max. Licht im Mébel, N°3 2023



Schalten und Steuern p. M A
Ladestationen MASSMOBEL

USB-Ladestation 12 V/24 V

> Hochwertige Ladestation mit hohem Ladestrom und A

USB-C

> Einsatzbereich: Caravan, Bootsbau, Mdbel

> Werkstoff: Kunststoff

> Farbe/Oberflache: tiefschwarz, ahnlich RAL 9005

> Ausgangsspannung: 5V

> Ausgangsleistung: 15W

> fir Plattendicke: <19 mm

> Montage: Durchgangsbohrung und
riickseitiger Konterring

> Bohrlochdurchmesser: 29 mm

> MaBe (J x H): 36 x 38 mm

Hinweis

Netzteil-Leistung mindestens 20 W pro Ladestation.
Nicht mit Loox5-ECO Netzteilen verwendbar.

Montagehinweis

Beim Einsatz eines 6-fach-Verteilers mit Schaltfunktion oder
Héfele Connect Mesh bitte diese Ladestation immer an den
7. Ausgang (Dauerstrom) des 6-fach-Verteilers anschlieBen

Lieferumfang
1 USB-Ladestation mit 2 m Zuleitung

Ladebuchsentypen ‘ Ladestrom
A
1 x USB-A 3 1820.89.148
2 x USB-A 2x25 1820.89.158
1 x USB-A gesamt 3,6 820.89.159
1 x USB-C
Abpackung: 1 Stlick
Hinweis
Nur mit Loox5 Netzteil verwendbar
Seite 51 / Artikel-Nr. 833.77.973 od. 833.77.974
[s¢]
[aV)
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é @ Verlangerungsleitung Loox5 2-pol. » Seite 48
o



Verteilen und Versorgen Loox5

Verteiler

P.MA

MASSMOBEL

6-fach Verteiler mit Multi-Schaltfunktion Hafele Loox5

Box-to-Box, mit Schaltfunktion fiir bis zu 3 Schalter

52 f0)

> Multi-Schaltfunktion fur bis zu 3 Schalter

> Steckverbindung Box-to-Box

> Permanente sanfte Ein-/Aus-Funktion, unabhangig vom
verwendeten Schalter

> Die Verbindung der Verteiler mit dem Netzteil kann per
Box-to-Box-Steckverbindung oder mit einer Verlange-
rungsleitung erfolgen. Es kdnnen beliebig viele Verteiler
an das Netzteil angesteckt werden.

> Maximalleistung beachten!

01 ALl
L] ®1—2 [
7102 7102
[ ®3—4 [
IO [~]03
il 56 ]

Gruppenschaltung

K

Digitale Kreuzschaltung

Eingange

®1—6

Oder-Schaltung

Ausgange

1 x Stecker, Loox5 2-pol. 24 V | 1 x Buchse,

Box-to-Box
Abpackung: 1 oder 50 Stlick

Loox5 2-pol. 24 V Box-to-Box

> Einsatzbereich: zum Ein-/Ausschalten
und Dimmen (0-100%)
> Werkstoff: Kunststoff
> Farbe/Oberflache: schwarz
> MaBe (L x B x H): 120 x 50 x 16 mm
> Schaltfunktion: mit Multi-Schaltfunktion
> Montage: zum Schrauben
zum Kleben

Lieferumfang
1 Verteiler inkl. Befestigungsmaterial
(Klebeband und Schrauben)

Betriebsarten
3 Betriebsarten:

Gruppenschaltung (rote Feedback-LED)
Schalter 1 = Ausgénge 1 und 2
Schalter 2 = Ausgénge 3 und 4
Schalter 3 = Ausgénge 5 und 6

Oder-Schaltung (blaue Feedback-LED)

Einschalten Uber Schalter 1, 2 oder 3, zum Ausschalten werden
alle eingeschalteten Schalter erneut betéatigt

In der Betriebsart Oder-Schaltung darf kein Dimmer verwendet
werden!

Digitale Kreuzschaltung (griine Feedback-LED)
Einen Schalter (1, 2 oder 3) betétigen zum Ein-/Ausschalten aller
Ausgéange

Hinweis:
Nur mit Loox5-Netzteil Seite 51 oder mit Loox5 ECO Netzteil und
Verlangerungleitung 833.95.717 (2 m) Seite 48 zu verwenden.

Geschaltete Steuereingange Leistungs- Artikel-Nr.
Ausgange belastbarkeit
w

6 x Buchse, 3 x Buchse, 120 833.95.829
Loox 2-pol. 24 V | Loox Schalter

P. Max. Licht im Mébel, N°3 2023



Vernetzen
Verteiler und Fernbedienung - Eco

4-fach-Verteiler im Set mit Fernbedienung Hafele Connect Mesh Eco

})

Monochrom

4-fach-Verteiler monochrom
(8 Erweiterungs-Verteiler moglich)

P. Max. Licht im M&bel, N°3 2023

P.MA

MASSMOBEL

> Sets ab Werk gekoppelt flir sofortige Inbetriebnahmen
> |deal fir kleine Netzwerke mit max. 4 Verteilern und

1 Fernbedienung

> Einsatzbereich:

> Verwendbar fiir:
> Werkstoff:

> Farbe/Oberflache:
> MaBe:

> Anzahl Verteiler pro
Netzwerk max.:

> Entfernung innerhalb
des Netzwerks

> Anzahl Anschlisse:

> Standby-Leistungs-
aufnahme:

Lieferumfang:

zum Ein-/Ausschalten und
Dimmen (0-100 %)

flr monochrome Leuchten
Kunststoff

schwarz

Verteiler: 105 x 50 x 16 mm,
Fernbedienung: 125 x 40 x 12 mm
4

10 m

1 x Eingang mit Stecker Box to Box,

1 x Ausgang Buchse Box to Box,

4 x Ausgang Verbraucherbuchsen
(2-polig), steuerbar mit Fernbedienung

<0,5W

1 4-fach-Verteiler monochrom
1 Fernbedienung inkl. Batterie

Funktionsweise

Uber die Fernbedienung wiahlen Sie einen der vier Ausgénge
(Ausgang 1, 2, 3 oder 4) und st euern diesen Ausgang gleich-
zeitig an allen Verteilern des Netzwerks (Ein/Aus, Dimmstufe).

Memory-
funktion

ja (auch bei
stromlos)

Abpackung: 1 Stiuick

Hinweis

Leistungsbelastbarkeit ‘ArtikeI-Nr.
w

‘ 72 ‘ 850.00.982

Fir maximalen Leistungsumfang mit Schaltfunktion und
App-Steuerung bitte 6-fach-Verteiler Hafele Connect Mesh

verwenden.

Entfernungsangabe innerhalb des Netzwerks gilt bei freier Sicht.
Hindernisse und elektromagnetische Stérquellen kénnen die
Reichweite verringern. Ein weiterer 4-fach-Verteiler kann als
Signalverstarker eingesetzt werden, um den Reichweitenverlust

auszugleichen.

Maximale Leitungslange vom Netzteil bis zum Verteiler 2 m.
Memory-Funktion fur priméarseitiges Ausschalten bei
12-V-Version erst ab Produktionsdatum Q1/2023 verfligbar.

Bestellhinweis

Erweiterbar auf bis zu 4 Verteiler (monochrom).
Erweiterungs-Verteiler und Netzteile bitte separat bestellen.

Nennspannung beachten!

Hinweis:

Nur mit Loox5-Netzteil Seite 51 oder mit Loox5 ECO Netzteil und
Verlangerungleitung 833.95.717 (2 m) Seite 48 zu verwenden.



Vernetzen
Verteiler und Fernbedienung - Eco

4-fach-Verteiler im Set mit Fernbedienung Hafele Connect Mesh Eco

})

Multi-WeiB

4-fach-Verteiler multi-weif3
(8 Erweiterungs-Verteiler méglich)

P.MA

MASSMOBEL

> Sets ab Werk gekoppelt flir sofortige Inbetriebnahmen
> |deal fir kleine Netzwerke mit max. 4 Verteilern und

1 Fernbedienung

> Einsatzbereich:

> Verwendbar fiir:
> Werkstoff:

> Farbe/Oberflache:
> MaBe:

> Anzahl Verteiler pro
Netzwerk max.:

> Entfernung innerhalb
des Netzwerks

> Anzahl Anschlisse:

> Standby-Leistungs-
aufnahme:

Lieferumfang:

zum Ein-/Ausschalten und Dimmen
(0-100 %) sowie Multi-WeiB-Farb-
wechsel

fir Multi-WeiB-Leuchten

Kunststoff

schwarz

Verteiler: 105 x 50 x 16 mm,
Fernbedienung: 125 x 40 x 12 mm
4

10 m

1 x Eingang mit Stecker Box to Box,
1 x Ausgang Buchse Box to Box,

4 x Ausgang Verbraucherbuchsen
(multi-weiB), steuerbar mit
Fernbedienung

<0,5W

1 4-fach-Verteiler Multi-Weif
1 Fernbedienung inkl. Batterie

Funktionsweise

Uber die Fernbedienung wiahlen Sie einen der vier Ausgénge
(Ausgang 1, 2, 3 oder 4) und st euern diesen Ausgang gleich-
zeitig an allen Verteilern des Netzwerks (Ein/Aus, Dimmstufe).

Memory-
funktion

ja (auch bei
stromlos)

Abpackung: 1 Stiuick

Hinweis

Leistungsbelastbarkeit ‘ArtikeI-Nr.
w

‘ 72 ‘ 850.00.984

Fir maximalen Leistungsumfang mit Schaltfunktion und
App-Steuerung bitte 6-fach-Verteiler Hafele Connect Mesh

verwenden.

Entfernungsangabe innerhalb des Netzwerks gilt bei freier Sicht.
Hindernisse und elektromagnetische Stérquellen kénnen die
Reichweite verringern. Ein weiterer 4-fach-Verteiler kann als
Signalverstarker eingesetzt werden, um den Reichweitenverlust

auszugleichen.

Maximale Leitungslange vom Netzteil bis zum Verteiler 2 m.

Bestellhinweis

Erweiterbar auf bis zu 4 Verteiler (multi-weiB).
Erweiterungs-Verteiler und Netzteile bitte separat bestellen.

Nennspannung beachten!

Hinweis:

Nur mit Loox5-Netzteil Seite 51 oder mit Loox5 ECO Netzteil und
Verlangerungleitung 833.95.717 (2 m) Seite 48 zu verwenden.

P. Max. Licht im Mébel, N°3 2023



Vernetzen p. M A

Verteiler und Fernbedienung - Eco

4-fach-Verteiler Hafele Connect Mesh Eco

MASSMOBEL

P. Max. Licht im M&bel, N°3 2023

3)

Einzelteile zur Erweiterung der Sets

4-fach-Verteiler Multi-Wei3

> Einzelteile zur Erweiterung eines Sets auf bis zu 4 Verteiler
> Einfache Kopplung an bestehendes Set ohne Einsatz

der App

> Einsatzbereich:

> Verwendbar fiir:
> Werkstoff:

> Farbe/Oberflache:
> MaBe:

> Anzahl Verteiler pro
Netzwerk max.:

> Entfernung innerhalb
des Netzwerks

> Anzahl Anschlisse:

> Standby-Leistungs-
aufnahme:

Lieferumfang:
1 4-fach-Verteiler

Funktionsweise

zum Ein-/Ausschalten und Dimmen
(0-100 %), je nach Variante auch
Multi-WeiB- oder RGB-Farbwechsel
fir Multi-WeiB-Leuchten

Kunststoff

schwarz

Verteiler: 105 x 50 x 16 mm,
Fernbedienung: 125 x 40 x 12 mm
4

10 m

1 x Eingang mit Stecker Box to Box,
1 x Ausgang Buchse Box to Box,

4 x Ausgang Verbraucherbuchsen,
steuerbar mit Fernbedienung

<0,5W

1 Fernbedienung schaltet 1 Kanal (alle vier Ausgénge) entweder

an Verteiler 1, 2, 3 oder 4.

Memory-
funktion
ja (auch bei

stromlos)
ja (auch bei

stromlos)

Leistungsbelastbarkeit Artikel-Nr.
w
72 ‘ 850.00.920

72 ‘ 850.00.958

Abpackung: 1 Stlick

Hinweis

Kopplung des Verteilers an vorhandenes Netzwerk erforderlich.
Entfernungsangabe innerhalb des Netzwerks gilt bei freier Sicht.
Maximale Zuleitung vom Netzteil bis zum Verteiler 2 m.

H
~



Verteilen und Versorgen Loox5
Verlangerungsleitungen

Verléangerungsleitung, Hafele Loox5, 5 A

fiir Loox5 monochrome Leuchten und andere 2-polige Verbraucher (Ladestationen, Audio) und Verteiler

P.MA

MASSMOBEL

~
‘9\?‘\ > Strombelastbarkeit: 5A
> Leitungsquerschnitt AWG: 18
19/‘ > Werkstoff: Kunststoff
g > Anzahl Einzelleitungen: 2
> Stecker Bohrloch- 8 mm
durchmesser:
‘,913 > Buchse Bohrloch- 13 mm
‘\ durchmesser:
Hinweis

Maximale Leitungslange vom Loox5-Netzteil zum Verbraucher
10 m. Durch groBe Kabelldngen entstehen in Verbindung mit
groBen Lasten (Bandléangen) Spannungsverluste im Kabel.

Diese fuhren zu sichtbaren Helligkeitsverlusten der Leuchte.

Die bei den Leuchten angegebenen Beleuchtungsstéarken
wurden mit der Nennausgangsspannung des Netzteils bestimmt
(12 V bzw. 24 V).

Lieferumfang
1 Verlangerungsleitung Stecker/Buchse

‘ Eingange ‘ Ausgange ‘ Artikel-Nr.
\ \ '500mm 1000 mm 2000 mm
1 x Stecker, Loox5 2-pol. 24 V 1 x Buchse, Loox5 2-pol. 24 V 1833.95.719  833.95.718  833.95.717

Abpackung: 1 Stlick

Multi-WeiB-Verlangerungsleitung, Héafele Loox5, 3,5 A

fiir Loox5 Multi-WeiB-Leuchten

> Strombelastbarkeit: 3,5A

> Leitungsquerschnitt AWG: 20

> Werkstoff: Kunststoff

> Anzahl Einzelleitungen: 3

> Stecker Bohrloch- 9 mm
durchmesser:

> Buchse Bohrloch- 13 mm
durchmesser:

Hinweis

‘ Eingange

‘ 1 x Stecker, Loox5 3-pol. MW 24 V

Abpackung: 1 Stlick

‘ Ausgénge

Maximale Leitungslange vom Loox5-Netzteil zum Verbraucher
10 m. Durch groBe Kabelldngen entstehen in Verbindung mit
groBen Lasten (Bandlangen) Spannungsverluste im Kabel.
Diese fiihren zu sichtbaren Helligkeitsverlusten der Leuchte.

Die bei den Leuchten angegebenen Beleuchtungsstéarken
wurden mit der Nennausgangsspannung des Netzteils bestimmt

(12 V bzw. 24 V).

Lieferumfang

1 Verlangerungsleitung Stecker/Buchse

‘ 1 x Buchse, Loox5 3-pol. MW 24 V

Kabelldange  Artikel-Nr.
mm

‘ 2000 ‘ 833.95.720

P. Max. Licht im Mébel, N°3 2023




Vertg_llen und Vers_orgen Loox5 p. MA
Verlangerungsleitungen MASSMOBEL

4-fach-Verlangerungsleitung, Hafele Loox5, 5 A

fiir Loox5 monochrome Leuchten und andere 2-polige Verbraucher (Ladestationen, Audio) und Verteiler

> Strombelastbarkeit: 5A

> Leitungsquerschnitt AWG: 18

> Werkstoff: Kunststoff

> Anzahl Einzelleitungen: 2

> Stecker Bohrloch- 8 mm
durchmesser:

> Buchse Bohrloch- 13 mm
durchmesser:

Hinweis

Maximale Leitungslange vom Loox5-Netzteil zum Verbraucher
10 m. Durch groBe Kabelldngen entstehen in Verbindung mit
groBen Lasten (Bandléangen) Spannungsverluste im Kabel.

Diese fuhren zu sichtbaren Helligkeitsverlusten der Leuchte.

Die bei den Leuchten angegebenen Beleuchtungsstérken
wurden mit der Nennausgangsspannung des Netzteils bestimmt
(12 V bzw. 24 V).

Lieferumfang
1 Verlangerungsleitung Stecker/4 Buchsen

Eingédnge Ausgange Kabelldnge  Artikel-Nr.
mm
‘ 1 x Stecker, Loox5 2-pol. 24 V ‘ 4 x Buchse, Loox5 2-pol. 24 V ‘ 6500 ‘ 833.95.743

Abpackung: 1 Stlick

P. Max. Licht im M&bel, N°3 2023



Verteilen und Versorgen Loox5
Netzteile 24 V

mit Schaltfunktion fiir 1 Schalter

52 J0)

Netzteil, 20 W, 230 V

Netzteil, 40 W, 230 V

Anschluss von Verteilern
@®
Ao b S
®

@ Verteiler mit Box-to-Box Anschluss kdnnen nicht direkt
eingerastet werden. Es ist eine Verlangerungsleitung
erforderlich. Bitte separat bestellen.

@ 6-fach-Verteiler mit integrierter Zuleitung kénnen direkt
angeschlossen werden

Netzteil Hafele Loox5, 24 V DC. ECO

P.MA

MASSMOBEL

> mit Schaltfunktion
> extra flach 16 mm

> 24-V-Netzteile mit Stecksystem der Generation Loox5

> Ausfuhrung:
> Einsatzbereich:

> Werkstoff:

> Farbe/Oberflache:
> Netzfrequenz:

> Ausgangsspannung:

> Geschaltete Ausgénge:

> Steuereingange:
> Lebensdauer:
> Montage:

> Montagehinweis:

Hinweis

mit Uberlastschutz

fur LED-Leuchten (nicht fir
andere Verbraucher)

Kunststoff

schwarz

50-60 Hz

24V DC + 3%

4 x Buchsen, Loox5 2-pol. 24 V
1 x Buchse, Loox Schalter
30000 h

zum Schrauben,

zum Kleben

Ausreichende Luftzufuhr und
Zirkulation am Einbauort
sicherstellen. Revisions6ffnung
vorsehen.

Bei Auswahl des Netzteils regionale Netzspannung beachten!
Fiir Dauerbetrieb bitte Loox5-Netzteile mit 50000 h
Lebensdauer verwenden.

Maximale Leitungslange vom Loox5-Netzteil zum
Verbraucher: 10 m.

Durch groBe Kabellangen entstehen in Verbindung mit groBen
Lasten (Bandlangen) Spannungsverluste im Kabel.

Diese fuhren zu sichtbaren Helligkeitsverlusten der Leuchte.
Die bei den Leuchten angegebenen Beleuchtungsstéarken
wurden mit der Nennausgangsspannung des Netzteils bestimmt
(12 V bzw. 24 V).

Lieferumfang
1 Netzteil inkl. Befestigungsmaterial

@ B & @ @ @ sery ip2o .} W

Netzspannung Ausgangs-  Ausgangs- Max. Standby- Umgebungs- MaBe (L x Bx H) Abpackung  Artikel-Nr.

\'} leistung W strom A Leistungsaufnahme W temperatur °C mm Stiick

220-240 V AC: typische Netzspannung z. B. fiir EU, UK, AU, KR

220-240 20 0,83 0,2 -25-45 138 x50 x 16 1 oder 50 833.75.933
40 1,67 0,5 -25-45 190 x 60 x 16 1 oder 40 833.75.935

Bestellhinweis

Einspeisleitung mit Euro-Flachstecker 833.89.002 bitte separat bestellen.
Alternative Einspeisleitungen mit offenen Kabelenden oder mit Schaltern erhaltlich.
Landerspezifische Leitungen mit Kleingeratebuchse C7 auf www.haefele.at

P. Max. Licht im Mébel, N°3 2023



Verteilen und Versorgen Loox5
Netzteile 24 V

Netzteil mit Einspeisleitung, Hafele Loox5 24 V DC

P.MA

MASSMOBEL

> extra flach 16 mm

230V | C (EV)

> 24-V-Netzteile mit Stecksystem der Generation Loox5

A

> Ausflihrung:

> Farbe:

> Werkstoff:

> Netzspannung:
> Netzfrequenz:
> Eingénge:

Netzteil, 20 W

> Ausgénge:

> Lebensdauer:
> Montage:
> Montagehinweis:

Netzteil, 40 W
Hinweis

10 m.

(12 V bzw. 24 V).

Lieferumfang

> Ausgangsspannung:

mit Uberlastschutz

schwarz

Kunststoff

100-240 V

50-60 Hz

1 x Stecker Kleingerate C8
24V DC

1 x Buchse, Loox5 2-pol. 24 V
Box-to-Box

>50000 h

zum Schrauben
Ausreichende Luftzufuhr und
Zirkulation am Einbauort
sicherstellen.
Revisionso6ffnung vorsehen.

Maximale Leitungslange vom Loox5-Netzteil zum Verbraucher:

Durch groBe Kabelldngen entstehen in Verbindung mit
groBen Lasten (Bandlangen) Spannungsverluste im Kabel.
Diese fuihren zu sichtbaren Helligkeitsverlusten der Leuchte.
Die bei den Leuchten angegebenen Beleuchtungsstarken
wurden mit der Nennausgangsspannung des Netzteils bestimmt

1 Netzteil inkl. Befestigunsmaterial

Netzteil, 90 W

YT 120 O D sy © c@s

Ausgangsleistung Standby-Leistungsverbrauch W Umgebungstemperatur
w °C

20 0.2 -25-45

40 03 -25-45

90 03 -25-45

1 Einspeisleitung 2 m mit Euro-Flachstecker

MaBe (L x B x H) ‘ Artikel-Nr.
1140 x 50 x 16 1833.77.972
1191 x60x 16 1833.77.973
1316 x 70 x 16 833.77.974

Abpackung: 1 Garnitur

Bestellhinweis
Alternative Einspeisleitungen mit offenen Kabelenden oder mit Schaltern erhéltlich.
Landerspezifische Leitungen mit Kleingeratebuchse C7 auf Anfrage erhaltlich.

P. Max. Licht im M&bel, N°3 2023



Verteilen und Versorgen Loox5

Verteiler

6-fach Verteiler, Hafele Loox5, 24 V, ohne Schaltfunktion

P.MAX

MASSMOBEL

> ungeschaltete Ausgénge mit Dauerstrom A

> Ausflihrung:

> Werkstoff:

> Farbe/Oberflache:
> Eingénge:

> Ausgéange:

> MaBe (L x B x H):

Lieferumfang
1 Verteiler

Leistungsbelastbarkeit W
120

ohne Schaltfunktion
Kunststoff

schwarz

1 x Stecker, Loox5 2-pol. 24 V
6 x Buchse, Loox5 2-pol. 24 V
70 x 30 x 14 mm

Artikel-Nr.
833.77.839

Abpackung: 1 Stiick

P. Max. Licht im Mébel, N°3 2023



Badausstattung p. M A
Badezimmerspiegel MASSMOBEL

Badezimmerspiegel Hafele

optionale Spiegelheizung, beleuchtet (3 Lichtfarben), IP44

> fertig konfektioniert inklusive Netzteil und Beleuchtung

> vertikale oder horizontale Montage

> leicht zu reinigen dank integriertem Berlhrungssensor in
der Spiegeloberflache

> optionale Spiegelheizung gegen Beschlagen

> Einsatzbereich: Badezimmer

> Eigenschaften: Helligkeit einstellbar,
Farbtemperatur einstellbar,
integrierter Berlihrungssensor auf

Spiegeloberflache,
Beleuchtung im Glas eingelassen
> Werkstoff: Glas
LED-Profil: Aluminium
> Netzspannung: 220V
> Netzfrequenz: 60 Hz
> Stecker Netzspannung: C (Euroflachstecker) 2-pol.
> Nennspannung: 12V DC
> Farbwiedergabeindex Ra: =90
> Schutzart: P44
‘ > Energieeffizienzklasse: F
> Montage: zum Schrauben
Hinweis
Der Spiegel enthalt eingebaute LED-Lampen,
] die nicht ausgetauscht werden kénnen.
il H—T Leistungsangaben gelten fir LED inkl. Spiegelheizung.
| | Anteil Spiegelheizung bei 900 x 700 mm: 23 W,
bei 1200 x 900 mm: 30 W.
Technische Daten
S
© Lichtfarbe warmweiB 3100 K /
kaltweil3 4700 K/
tageslichtweiB 7000 K
: ! P44
L;:;;(; 7777777777 34541:7 Ausfiihrung m?nﬁe (B x H) I‘;veistung Artikel-Nr.
beleuchtet 700 x 900 25 983.75.006
beleuchtet, 700 x 900 48 983.75.007
mit Spiegelheizung
beleuchtet 1200 x 900 29 983.75.008
beleuchtet, 1200 x 900 59 983.75.009
mit Spiegelheizung

P. Max. Licht im M&bel, N°3 2023



Badausstattung p. M A
Badezimmerspiegel MASSMOBEL

Badezimmerspiegel Hafele

optionale Spiegelheizung, beleuchtet (3 Lichtfarben), IP44

> fertig konfektioniert inklusive Netzteil und Beleuchtung

> leicht zu reinigen dank integriertem Berlhrungssensor in
der Spiegeloberflache

> optionale Spiegelheizung gegen Beschlagen

| > Einsatzbereich: Badezimmer
> Eigenschaften: Helligkeit einstellbar,
. Farbtemperatur einstellbar,
| ! integrierter Berlihrungssensor
| auf Spiegeloberflache,
Y f Beleuchtung auBen
A 4 > Werkstoff: Glas,
LED-Profil: Aluminium
% > Netzspannung: 220V
> Netzfrequenz: 60 Hz
> Stecker Netzspannung: C (EU Flachstecker) 2-pol.
1T > Nennspannung: 12V DC
> Farbwiedergabeindex Ra: =90
S > Schutzart: P44
§ > Energieeffizienzklasse: F
§ > Montage: zum Schrauben
Hinweis
Der Spiegel enthalt eingebaute LED-Lampen,
E.ﬂ: die nicht ausgetauscht werden kénnen.

Leistungsangaben gelten fir LED inkl. Spiegelheizung.
Anteil Spiegelheizung bei @ 600 mm: 12 W,
bei @ 800 mm: 23 W.

Technische Daten

Lichtfarbe warmwei3 3100 K/
kaltweiB 4700 K /
tageslichtweiB 7000 K

IP44
Ausfiihrung Durchmesser Leistung Artikel-Nr.
mm w

beleuchtet 600 20 983.75.004
beleuchtet, 600 32 983.75.003
mit Spiegelheizung

beleuchtet 800 24 983.75.005
beleuchtet, 800 47 983.75.010
mit Spiegelheizung

P. Max. Licht im Mébel, N°3 2023



STAURAUM P.MAX

MASSMOBEL

Schrankausstattung
Hauswirtschaftsraum

Waschekorb Hailo
fir Montage hinter Fronten

> Ausfiihrung: mit Griffen fur eine leichte Entnahme
> Werkstoff: Rahmen: Stahl, Eimer: Kunststoff
> Auszugsart: seitlich abgedeckter synchronisierter und
gedampfter Uberauszug
> Seitenwanddicke: 16—19 mm selbstjustierbar
> flr lichte Korpustiefe: >530 mm
> Montage: zum Schrauben an die Seitenwand
fir Farbe Fassungs- MaRe Artikel-Nr.
Korpus- vermoégen (B x T x H)
breite
mm | mm
Waschekorb Hailo
450 1 Waschekorb: weif}, 2 x 33 412/418 x | 502.72.722
1 Waschekorb: blau 528 x 545
500 1 Waschekorb: weif}, ' 2x 33 462/468 x | 502.72.723
1 Waschekorb: blau 528 x 545
600 Waschekorbe 1 x 331, | 2 x 33, 562/568 x | 502.72.724
1x121,1x251: weil | 1x12, 528 x 545
Waschekorb 1 x331: | 1x2,5
blau
Behalterdeckel 12 I:
weild
Ersatzeimer
Kunststoff weil}, 33 - 502.72.990
378 x 254 x 521 mm
(LxBxH)
Kunststoff blau, 33 - 502.72.993
o 378 x 254 x 521 mm
% (LxBxH)
o Abpackung: 1 Stiick
z
2
g > P.Max Korpen mit 45,1 cm bzw. 60,1 cm Breite n
c eingeben.
=
Q
—
%
©
=
o



Ausstattung fur Kleiderschranke, Garderoben p. MAx
Schuhschrankauszug MASSMOBEL

Schuhschrankauszug

> Auszugsregal mit Schuhtablaren fir bis zu 50 Paar Schuhe
> ausziehbar und drehbar (180°) fir beidseitigen Zugriff u
> Tablare leicht ein- und aushangbar, dadurch problemlose Reinigung mdéglich

720 > Ausfiihrung: Schuhschrankauszug 180° drehbar
; > Werkstoff: Tragrahmen: Stahl,
i _ Tablare: Kunststoff
i > Montage: zum Schrauben an Boden und
: Fachboden
! > fiir lichte Korpushohe: 1680/1000 mm
: > fiir lichte Korpustiefe: >365 mm

> Tragkraft: pro Tablar 2 kg
> max. Schuhléange 310 mm

Lieferumfang

1 Tragrahmen

1 Auszugsfiihrung oben und unten
14 Tablare

1 Befestigungsmaterial

80+1

-~ (422) =]~ 365~

Fiir bis zu 50 Paar Schuhe | Farbe Artikel-Nr.
Schuhschrankauszug 1680 mm grau 806.22.501

weift 806.22.701

R schwarz 806.22.401

Abpackung: 1 Garnitur

Lieferumfang

1 Tragrahmen

1 Auszugsfiihrung oben und unten
6 Tablare

1 Befestigungsmaterial

Fiir bis zu 20 Paar Schuhe Farbe Artikel-Nr.
Schuhschrankauszug 1000 mm grau 806.22.500
weily 806.22.700
schwarz 806.22.400

Abpackung: 1 Garnitur
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Kele) C
KONFIGURATOR.

Service* MaBgeschneidert-Linearleuchten nach MaB.
Bestellen. Auspacken. Einstecken. Fertig.

Mit dem Héfele Loox-Konfigurator LED-Bander, Aluminiumprofile und Schalter
nach MaB bestellen. In wenigen Schritten zur individuellen Linearleuchte.

Sie haben weniger Arbeitsaufwand, keinen Verschnitt und bekommen Licht

im Mobel fertig zur Montage geliefert.

Der Hafele Loox-Konfigurator steht fir Sie bereit: www.haefele.at/loox-topco

WILLKOMMEN BEIM LOOX-KONFIGURATOR.

01. Profil auswahlen

LED-Linearleuchten nach MagB.

Bereits ab einem Stlck.

57
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P.MAX

MASSMOBEL

1040 Wien, FavoritenstraBe 64 T: 01/505 28 40

1050 Wien, Reinprechtsdorfer StraBe 72 T: 01/545 51 32
1090 Wien, Alser StraBe 54 T: 01/405 31 60

1100 Wien, FavoritenstraBe 143 T: 01/606 00 30

1110 Wien, Simmeringer HauptstraBe 135 T: 01/749 68 89
1120 Wien, Tivoligasse 3 T: 01/813 33 43

1140 Wien, Albert-Schweitzer-Gasse 1C T: 01/577 39 20
1150 Wien, HutteldorferstraBe 62 T: 01/982 33 54

1160 Wien, ThaliastraBe 59 T: 01/492 10 79

1190 Wien, Heiligenstadter StraBe 134-138 T: 01/370 91 00
1210 Wien, Floridsdorfer HauptstraBe 22 T: 01/278 13 02
1210 Wien, Prager StraBe 63 T: 01/270 7324

1220 Wien, Gewerbepark Stadlau T: 01/734 42 62

1220 Wien, Wagramer StraBe 184 T: 01/257 54 60

2000 Stockerau, Horner StraBe 103 T: 02266/639 00-0
2000 Stockerau, Horner StraBe 106 T: 02266/617 40
2345 Brunn am Gebirge, SC-B17, vis a vis SCS T: 02236/325 62
2353 Guntramsdorf, Triester StraBe 90 T: 02236/444 41
2700 Wr. Neustadt, Neunkirchner StraBe 139 T: 02622/221 89
3106 St. Polten, Mariazeller StraBe 212 T: 02742/881 257
4040 Linz Urfahr, Freistadter StraBe 291 T: 0732/244 033
4060 Linz Leonding, KornstraBe 18 T: 0732/681 019

4600 Wels, Salzburger StraBe 222 T: 07242/412 35

4840 Vocklabruck, FriedhofstraBe 8 T: 07672/223 01
5020 Salzburg, SterneckstraBe 48 T: 0662/874 605

5301 Eugendorf, Salzburger StraBe 22 T: 06225/8312
6020 Innsbruck, Haller StraBe 182 T: 0512/264 996

7501 Unterwart, Ipari Park 31 T: 03352/315 40

8010 Graz, Munzgraben StraBe 231 T: 0316/475 117

8053 Graz, Karntner StraBe 233 T: 0316/296 550

8605 Kapfenberg, Wiener StraBe 89 T: 03862/234 20
9020 Klagenfurt, Volkermarkter StraBe 200 T: 0463/312 25

Peter Max Vertriebsgesellschaft m.b.H.
2000 Stockerau, Horner StraBe 103, Austria
T: +43 / 2266 / 63900-0

E: office@petermax.at

PETERMAX.AT
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© Peter MAX Vertriebsgesellschaft m.b.H. Satz- Druckfehler vorbehalten.





